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1. Einfiihrung

Sehr geehrter Kunde,

Mit der Programmiersoftware talento dialog plus kénnen Sie am PC
Schaltprogramme (Wochen-, Ferien-, Jahres- und Astroprogramme) fiir digitale
Zeitschaltuhren der Marke Grésslin erstellen.

Mit dem Programmiibertragungsgerét talento taxxi plus oder dem talento
LAN plus Modul kénnen Sie die erstellten Schaltprogramme auf die jeweilige
Zeitschaltuhr Gbertragen.

Der Umgang mit dem PC sowie praktische Erfahrungen mit Windows sind
Voraussetzung, um mit dieser Programmiersoftware erfolgreich zu arbeiten.

1.1 BestimmungsgemaBe Verwendung

Mit der Anwendersoftware kdnnen Sie Schaltprogramme fiir die folgenden
digitalen Zeitschaltuhren der Marke Grésslin erstellen.

o talento 471/472 plus

e talento 671 plus

e talento 892/992 plus

1.2 Symbolerklarung

Folgende Symbole werden in dieser Bedienungsanleitung verwendet:

Symbol | Bedeutung

m Information

1. Mehrschrittige Handlungsaufforderung

| 4 Einschrittige oder alternative Handlungsaufforderung
> Resultat zu einer Handlungsaufforderung

1.3  Lieferumfang / Zubehor

Im Lieferumfang enthalten sind
e Software-CD
e Bedienungsanleitung auf CD



2. Installation / Deinstallation
2.1  Software / Hardware Voraussetzungen

Software

Hardware

e Windows 95/98/NT/2000/XP/Vista/7

e Pentium, Pentium-MMX oder Pentium Il
e 512 MB RAM (1 GB empfohlen)
e Qptimale Bildschirmauflosung: 1280 x 1024 Pixel

Externe Hardware:
(Digitale Zeitschaltuhren und Zubehor):

e Jahresschaltuhr (talento 471, 472, 671, 892, 992 plus)
e talento taxxi plus = Handprogrammiergerat
e Serielles Kabel zum Anschluss an den PC

(handelstibliches 1:1-Kabel, im Lieferumfang des talento taxxi plus enthalten)

2.2 Installation unter Windows

1. Legen Sie die CD in das entsprechende Laufwerk.
2. Sofern sich das Installationsmenii nicht automatisch 6ffnet, klicken Sie mit

der Maus auf die Datei start.exe (CD).

> Das Menli fiir die Sprachauswahl 6ffnet sich.
3. Wahlen Sie die gewiinschte Sprache und bestatigen Sie Ihre Eingabe mit

[Cox 1
> Das Installationsmenii 6ffnet sich.

4. Klicken Sie auf und folgen Sie den Installationsanweisungen.
Wurde die Installation komplett ausgefiihrt, konnen Sie das Programm neu

starten.

2.3 Deinstallation

@talemo dialog plus

Willkommen beim Installations-
Assistenten fur talento dialog plus

Dieser Assistent wird Sie durch die Installstion von talento
dislog plus begleiten.

€5 wird empfohlen, vor der Installation alle anderen
damit: bestimmbe

Cuisrer> ] [abtrechen |

1§ | Bei der Installation wurde in der Ziel-Programmgruppe die Verkniipfung Abb. 1: Installationsmen(i
,Deinstallieren” angelegt. Loschen Sie die Software nicht manuell!




w

3.1

Programm starten

Programm durch Doppelklick auf das Symbol in der entsprechenden
Programmgruppe starten. (Namen haben Sie festgelegt)
> Es offnet sich die Startseite des Programms.

Wahlen Sie im Feld Sprache wahlen die gewiinschte Sprache.

Klicken Sie auf [Heves Progammersteten |, UM ein eigenes Schaltprogramm zu
erstellen.

Klicken Sie auf [ oasiofen ], um ein bereits gespeichertes
Schaltprogramm zu 6ffnen.

Klicken Sie auf [ Geewagmgmmed ], um ein Schaltprogramm aus dem
Handprogrammiergerét talento taxxi plus auf den PC zu iibertragen.
Klicken Sie auf [ Deemagwglan | um ein Schaltprogramm von der
Zeitschaltuhr via LAN-Modul auf den PC zu tbertragen.

Klicken Sie auf [ &wmndea |, um das Programm zu beenden.

Neues Schaltprogramm erstellen

Klicken Sie auf [Neves Progammersteten |, UM ein eigenes Schaltprogramm zu
erstellen.

> Es offnet sich die Seite , Zeitschaltuhr wahlen®.

Wahlen Sie im Feld Typ der Zeitschaltuhr den Zeitschaltuhrtyp, fiir den das

Schaltprogramm erstellt werden soll.

> Im Feld Anzahl Kandle wird automatisch die Anzahl der Kanéle der
Zeitschaltuhr angezeigt.

Je nach Zeitschaltuhrtyp kénnen Sie im Feld Anzahl Kanalerweiterungen

die Anzahl der Kanalerweiterungen einstellen.

Klicken Sie auf e« um Ihre Eingaben zu bestatigen.

> Es offnet sich die Seite ,,Standort wahlen“ (nur bei talento 892/992 plus).
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Was mdchten Sie tun?

Sprache wablen
2. —— - [ Mewes Programm ersteen | [ Datel offnen
[ Coemopmgrans |
> Ubertragung LAN
©2010 Grirssin GmbH All rights reserved.
Abb. 2: Neues Schaltprogramm — Startseite
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YOUR SENSES. OUR SOLUTIONS
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Abb. 3: Neues Schaltprogramm — Auswahl Zeitschaltuhr



7. Wahlen Sie im Feld Standort wéhlen ihren Standort N
(nur bei talento 892/992 plus). YOUR SENSES. OUR SOLUTIONS.
8. Klicken Sie auf @] um lhre Eingaben zu bestatigen.
> Es o6ffnet sich das Hauptmend.

3.2 Datei 6ffnen

3. Klicken Sie auf [_basiamen | um ein bereits gespeichertes
Schaltprogramm zu 6ffnen.
> Es offnet sich das Fenster ,0ffnen”.

4. Wahlen Sie den Ordner in dem die Datei liegt.

5. Offnen Sie die Datei durch einen Doppelklick oder wéhlen Sie die Datei und
Klicken auf [“ojien ]. M 0

1M
> Das Programm wird geladen und im Hauptmeni ge6ffnet. |, ,.::.;J ;:uw“‘mmm‘"

| My Recsived Fle:

panden
? Pidecs von GOPAdsn
e _iratatston o
Aubetaplstz

ﬁm—-

Hetowarumgedt  Diatedy:

Abb. 5: Neues Schaltprogramm — Datei 6ffnen




3.3 Ubertragung taxxi

3. Klicken Sie auf [~ tesmaguatand | um ein Schaltprogramm von einem
Handprogrammiergerat zu laden.

4. Wahlen Sie im Feld Port lesen die serielle Schnittstelle, an welche das
Handprogrammiergeréat angeschlossen ist.

5. Wahlen Sie im Feld Programmplatz den gewiinschten Speicherplatz,
welcher geladen werden soll.

6. Bestatigen Sie lhre Eingabe mit [ ok .
> Das Programm wird geladen und im Hauptmenii gedffnet.

YOUR SENSES. OUR SOLUTIONS.

e T E— [ ) (]

Abb. 6: Neues Schaltorogramm — Ubertragung taxxi



3.4  Ubertragung LAN

3. Klicken Sie auf [ Geemagngian ], um ein Schaltprogramm von der
Zeitschaltuhr via LAN-Modul auf den PC zu tbertragen.

> Es o6ffnet sich das Fenster ,Einstellungen®.

m Bevor Sie Daten aus der Zeitschaltuhr auslesen, miissen Sie das LAN-
Modul in der Software ,talento dialog plus“ konfigurieren!
Klicken Sie auf [Eisetimgen |, um die entsprechende Arbeitsgruppe anzuzeigen,
zu bearbeiten oder neu anzulegen.
Weitere Informationen finden Sie auf Seite 56, Kapitel 12
»Schaltprogramme via LAN-Modul tibertragen”

4. Sind bereits LAN-Module konfiguriert, klicken Sie auf o],
> Es offnet sich das Fenster ,Download“.

5. Waéhlen Sie im Feld Arbeitsgruppe die gewiinschte Arbeitsgruppe, in welcher
das LAN-Modul installiert ist.

6. Wahlen Sie im Feld Installation das LAN-Modul (Installationsname), von
welchem die Programme ausgelesen werden sollen.

7. Klicken Sie auf um das Auslesen zu starten.
> Es o6ffnet sich das Fenster ,Dateniibertragung*”.

> Bei erfolgreicher Ubertragung wird das ausgelesene Programm
angezeigt.

No o
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Abb. 7: Neues Schaltprogramm — Ubertragung LAN
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4. Benutzeroberflache
41  Uberblick

Meniileiste
Symbolleiste

Register

w2y e s s
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Abb. 9: Benutzeroberfléche - Uberblick



4.2 Meniileiste

4.4  Register

Menii Meniipunkte

Datei Neu; Offnen (Datei / talento taxxi plus / talento LAN plus);
Senden an (talento taxxi plus / talento LAN plus); Speichern;
Speichern unter; Drucken; Beenden

Bearbeiten | Neues Programm (EIN/AUS, Impuls, Zyklus)

Optionen Zeitschaltuhr wahlen; Standort wahlen; Anwenderspezifische
Symbole; Sprache éndern; Prioritat einstellen; Einstellungen
(talento LAN plus); Formatierung talento taxxi plus (auf talento
892/992 plus / auf talento 471/472/671 plus)

Hilfe Info; Hilfe

4.3  Symbolleiste

Schaltfache | Befehl

Projekt speichern

=

Projekt drucken

Register Funktion

Wochenprogramm Einstellungen des Wochenprogramms
Jahresprogramm Einstellungen des Jahresprogramms
Astroprogramm Einstellungen des Astroprogramms
CH1, ..., CH8 Kanalauswahl (Kanal 1, ..., Kanal 8)
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4.5  Grafische Darstellung (Grafik)

Die grafische Darstellung ermdglicht einen schnellen Uberblick iiber Start- und
Endzeit der einzelnen Schaltprogramme.

4.5.1 Wochenprogramm

Die Wochentage werden auf der vertikalen Achse, die Uhrzeit auf der horizontalen
Achse dargestellt.

4.5.2 Ferienprogramm (talento 471, 472, 671 plus)

Die Wochentage werden auf der vertikalen Achse, die Uhrzeit auf der horizontalen
Achse dargestellt.

» Aktivieren Sie Ferienprogramm um ein Ferienprogramm zu erstellen.

WoshenereaT e i
AT Jenz . . .
(B (. g ) ) el Bty Bk

G GU00 PR GRI0 DAGD DNOD SN0 OTOO DMO0 DR00 1000 1100 TRED E00 1A00 IBG0 NS0 TS0 TR0D 1RE0 0P G0 I3 3308

PEIRERE

Abb. 10: Grafische Darstellung — Wochenprogramm
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Abb. 11: Grafische Darstellung — Ferienprogramm
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45.3 Jahresprogramm i oy g

Die Kanale werden auf der vertikalen Achse, die Urzeit auf der horizontalen (ORI ] o 610 s o . 28 1108 0 10 1 1 8 e
Achse dargestellt. Der gewahite Kanal wird weiB hinterlegt. : I D N | T P s e EL £ e |

» Wahlen Sie im Register Alle Kanéle, um alle Kanéle anzuzeigen.
Eine Bearbeitung der Schaltprogramme auf dieser Ebene ist nicht mdglich.

Abb. 12: Grafische Darstellung — Jahresprogramm

4.5.4 Astroprogramm

Bei der Astroprogrammierung gibt es keine grafische Darstellung der
Schaltprogramme.

4.5.5 Skalierung einstellen

Das Raster fiir die grafische Darstellung kann (iber das Auswahlfeld Skalierung
eingestellt werden.

svateung

19.00 | 20000 | 21:00 | 22:00 | 23.00

Abb. 13: Skalierung einstellen

Folgende Rastereinstellungen sind maglich:
5 Minuten, 15 Minuten, 30 Minuten, 1 Stunde
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4.6 Tabellarische Darstellung

Bei Wochen-, Ferien-, Jahres- und Astroprogrammen werden in der Tabelle alle
Information eines Schaltprogrammes aufgeftihrt. Jeder Schaltbefehl (z. B. EIN
oder AUS) wird in einer Tabellenspalte dargestellt.

Wenn Sie mit der linken Maustaste auf einen Schaltbefehl in der Tabelle
klicken wird dieser hervorgehoben.

Wenn Sie mit der rechten Maustaste klicken, 6ffnet sich ein Menii. Wahlen
Sie Léschen, um das Schaltprogramm zu léschen.

4.6.1 Wochenprogramm

A Programmnummer der Schaltbefehle
B Artdes Schaltbefehls (EIN, AUS, Impuls, Zyklus EIN oder Zyklus AUS) e S e e e

C §tart- oder Endzeit des Schaltbefehls
Uber das Pull-Down Menii  lassen sich Stunden (hh) und Minuten (mm)
einstellen.

-

i—

(ot ]
alislfalt |
og

D Impulsdauer Abb. 14: Tabellarische Darstellung — Wochenprogramm
Die Impulsdauer zeigt die EIN-Schaltdauer des Schaltbefehls bei einem
Impuls- oder Zyklusprogramm.
Uber das Pull-Down Menii ¥ lassen sich je nach Zeitschaltuhr Tage (tt),
Stunden (hh), Minuten (mm) und Sekunden (ss) einstellen.

E Periode
Die Periode zeigt die Dauer eines Zyklus an.
Uber das Pull-Down Menii ' lassen sich Tage (tt), Stunden (hh), Minuten
(mm) und Sekunden (ss) einstellen.

F Wochentage
Sie konnen wahlen, an welchem Wochentag das jeweilige Schaltprogramm
gestartet oder beendet werden soll. Aktivieren Sie tdglich wenn der
Schaltbefehl jeden Tag ausgefiihrt werden soll.



4.6.2 Ferienprogramm (talento 471, 472, 671 plus)

A Programmnummer der Schaltbefehle

B Art des Schaltbefehls (EIN, AUS, Impuls, Zyklus EIN oder
Zyklus AUS)

C Start- oder Endzeit des Schaltbefehls
Uber das Pull-Down Menii [ lassen sich Stunden (hh) und Abb. 15: Tabellarische Darstellung — Ferienprogramm
Minuten (mm) einstellen.

D Impulsdauer
Die Impulsdauer zeigt die EIN-Schaltdauer des Schaltbefehls
bei einem Impuls- oder Zyklusprogramm.
Uber das Pull-Down Menii ¥ lassen sich Tage (tt), Stunden
(hh), Minuten (mm) und Sekunden (ss) einstellen.

E Periode
Die Periode zeigt die Dauer eines Zyklus an.
Uber das Pull-Down Menii [ lassen sich Tage (tt), Stunden
(hh), Minuten (mm) und Sekunden (ss) einstellen.

F Wochentage
Sie konnen wahlen, an welchem Wochentag das jeweilige
Schaltprogramm gestartet oder beendet werden soll.
Aktivieren Sie taglich wenn der Schaltbefehl jeden Tag
ausgefiihrt werden soll.

G Startdatum der Ferien
Uber das Pull-Down Menii ¥ lassen sich Tag und Monat
einstellen.

H Enddatum der Ferien
Uber das Pull-Down Menii ¥ lassen sich Tag und Monat
einstellen.

15




4.6.3 Jahresprogramm

Programmnummer der Schaltbefehle
Art des Schaltbefehls (EIN/AUS, Impuls, Zyklus)

Startzeit des Schaltbefehls
Uber das Pull-Down Menii * lassen sich Stunden (hh) und Minuten (mm)
einstellen.

Endzeit des Schaltbefehls
Uber das Pull-Down Menii ™ lassen sich Stunden (hh) und Minuten (mm)
einstellen.

Impulsdauer

Die Impulsdauer zeigt die EIN-Schaltdauer des Schaltbefehls bei einem
Impuls- oder Zyklusprogramm.

Uber das Pull-Down Menii [ lassen sich je nach Zeitschaltuhr Tage (tt),
Stunden (hh), Minuten (mm) und Sekunden (ss) einstellen.

Periode

Die Periode zeigt die Dauer eines Zyklus an.

Uber das Pull-Down Menii ' lassen sich Tage (tt), Stunden (hh), Minuten
(mm) und Sekunden (ss) einstellen.

Nur dieses Jahr

Sie konnen wahlen, ob der Schaltbefehl nur fiir das gewahlte Jahr gelten
soll oder jedes Jahr ausgefiihrt werden soll.

Aktivieren Sie nur dieses Jahr, wenn der Schaltbefehl nur fiir das
gewahlte Jahr gelten soll.

Abb. 16: Tabellarische Darstellung — Jahresprogramm



4.6.4 Astroprogramm

A B C D
A Programmnummer der Schaltbefehle ‘ ’ ‘
B Datumsbereich E T omat o, "oty
Der Datumsbereich zeigt das Start- und Enddatum des Astroprogramms. 2 e e o i e o r—roy
c Offset Abb. 17: Tabellarische Darstellung — Astroprogramm

Der Offsetbereich zeigt die Verschiebung der EIN-/AUS-Schaltzeiten bei
Sonnenauf- und Sonnenuntergang.

D Nachtabschaltung
Die Nachtabschaltung zeigt die EIN-/AUS-Schaltzeiten der Zeitschaltuhr,
welche zwischen Sonnenuntergang und Sonnenaufgang liegen,
z.B.23 -5 Uhr.

E Programm
Der Schaltzustand zeigt die gewahlte Art der Schaltbefehle bei Sonnenauf-
und Sonnenuntergang.
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5. Die Meniileiste
5.1 Das Menii DATEI

Neu

» Wihlen Sie Datei = Neu, um ein neues Schaltprogramm zu erstellen.
> Wenn Sie ein noch nicht gespeichertes Schaltprogramm geéffnet haben
erfolgt automatisch die Frage: ,Soll das Programm gespeichert werden?“
Wahlen Sie Ja/Nein um das Schaltprogramm zu speichern/nicht zu
speichern.

Offnen

» Wihlen Sie Datei > Offnen > Datei, um ein bereits gespeichertes
Schaltprogramm zu 6ffnen.

» Wihlen Sie Datei > Offnen > talento taxxi plus, um ein Schaltprogramm
aus dem Handprogrammiergerét talento taxxi plus auf den PC zu iibertragen
und zu offnen.

» Wihlen Sie Datei > Offnen - talento LAN plus, um ein Schaltprogramm
von der Zeitschaltuhr via LAN-Modul auf den PC zu tibertragen.

Senden an

» Wihlen Sie Datei > Senden an > talento taxxi plus, um ein
Schaltprogramm vom PC auf das Handprogrammiergerét talento taxxi plus
zu (ibertragen.

» Wahlen Sie Datei > Senden an - talento LAN plus, um ein
Schaltprogramm via LAN-Modul auf die Zeitschaltuhr zu Gibertragen.

m Detaillierte Informationen zum Ubertragen von Schaltprogrammen finden
Sie im Kapitel 12 ,,Schaltprogramme via LAN-Modul tibertragen“ und
Kapitel 13 ,Schaltprogramme via Handprogrammiergerét (ibertragen

[ talento dialog plus

i| Datei | Bearbeiten Optionen Hilfe
_] 2| Neu |
Offnen * im | Astroprogs
B Senden an r b———
A H5 |CHE |
Speichemn e
Speichern unter I Zyklus
Drucken lo3:00  04:00
Beenden |
j T T T T

Abb. 18: Menii DATEI

Speichern

» Waéhlen Sie in der Mentileiste Datei = Speichern, um das Schaltprogramm
zu speichern.
m Wahlen Sie einen geeigneten Namen fiir die Datei, welcher das spétere
Wiederfinden erleichtert. Die Dateiendung muss dabei immer .swp heiBen!

Speichern unter

» Wihlen Sie Datei > Speichern unter, um das Schaltprogramm unter einem
anderen Namen zu speichern.
E Wahlen Sie einen geeigneten Namen fiir die Datei, welcher das spétere
Wiederfinden erleichtert. Die Dateiendung muss dabei immer .swp heiBen!

Drucken
» Wihlen Sie Datei > Drucken, um das Schaltprogramm zu drucken.



Beenden

» Wahlen Sie in der Mentileiste Datei = Beenden, um die
Programmiersoftware zu verlassen.
> Wenn Sie ein noch nicht gespeichertes Schaltprogramm gedffnet haben
erfolgt automatisch die Frage: ,Soll das Programm gespeichert werden?“
Wahlen Sie Ja/Nein um das Schaltprogramm zu speichern/nicht zu
speichern.

5.2 Das Menii BEARBEITEN

Neues Programm

» Waéhlen Sie Bearbeiten = Neues Programm, um einen neuen EIN-/AUS-,
Impuls- oder Zyklus-Schaltbefehl zu erstellen.

: Datei
=) » [ B0 EinfAus
Wochenprogramm |Jahresprugramm | Astropr Impuls
R} _ —— ; Zvidus
CH1 CH2 |CH3 |CH4 | CH5 ]|c:-|s["_"' Ykll_

Abb. 19: Menii BEARBEITEN
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5.3 Das Menii OPTIONEN

@ talento dialog plus

. .. i Datei Bearbeiten
Zeitschaltuhr wahlen =1
» Wahlen Sie Optionen - Zeitschaltuhr wéhlen, um eine neue Zeitschaltuhr | Wochenprog [[ Jahre Standort wahlen [
zu wahlen oder um Kanalerweiterungen hinzuzufiigen. T Anwenderspezifische Symbole
> Wenn Sie ein noch nicht gespeichertes Schaltprogramm geéffnet haben lEﬂ?J'—-'Z"'EE"—"E! Sprache &ndern -
erfolgt automatisch die Frage: ,Wollen Sie das Programm speichern?“ -Elnﬁﬁ | I | Prioritat einstellen
Wahlen Sie Ja/Nein um das Schaltprogramm zu speichern/nicht zu E———— o Einstellungen v E
speichern | 00:00 | 01:00 | O : . A
: CHA | Eormatierung talento taxxi plus »
f - t = T - - T =
Standort wahlen Abb. 20: Menii OPTION
» Wihlen Sie Optionen - Standort wéhlen, um lhren Standort einzustellen.
Dieser dient der automatischen Berechnung der Feiertage bei der
Jahresprogrammierung.
Anwenderspezifische Symbole
» Wihlen Sie Optionen > Anwenderspezifische Symbole, um den einzelnen Einstellungen
Kandlen ein Symbol zuzuweisen. » Wahlen Sie Optionen > Einstellungen ->talento LAN plus, um
B Einstellungen fiir das LAN-Modul (talento LAN plus) vorzunehmen.
Sprache andern Siehe Kapitel 12.2 ,LAN-Modul - Einstellungen®.
» Wahlen Sie Optionen > Sprache &ndern, um die Sprache der . .
Programmiersoftware zu dndern. Formatierung talento taxxi plus
o » Wéhlen Sie Optionen > Formatierung talento taxxi plus - auf talento
Prioritat einstellen 892/992 plus oder auf talento 471/472/671 plus, um die Programmplatze

des Handprogrammiergerats , talento taxxi plus“ auf die entsprechende
Zeitschaltuhr zu formatieren.

Siehe Kapitel 13.2 ,,Programmplétze auf Handprogrammiergerat
formatieren®.

» Waéhlen Sie Optionen > Prioritét einstellen, um den verschiedenen
Programmtypen eine Prioritdt zuzuweisen.
Siehe Kapitel 7.4 ,Prioritdt von Schaltprogrammen einstellen.”
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5.4  Das Menii HILFE

Info

» Waéhlen Sie Hilfe > Info, um weitere Informationen zur Software zu
bekommen (Softwareversion, Impressum).

Hilfe

» Wihlen Sie Hilfe > Hilfe, um die Bedienungsanleitung zur Software im
PDF-Format zu 6ffnen.

[€ talento dialog plus

i Datei Bearbeiten Optionen | Hilfe
d=1>) Info 1]
W prog || Jahresprog i Hilfe  F1
CH1 [cH2 |
| EinfAus |.r|. |mpu|s||J'u' Zyldus|
"an-an | a1ean | Aenn | aaan | naan | nsnn | aean | n?

Abb. 21: Meni HILFE

21




6. Schaltbefehle

Im Wochen- und Jahresprogramm stehen drei Schaltbefehle zur Auswahl:

EIN/AUS e EIN schaltet den Kanal ein.
e AUS schaltet den Kanal aus

m Der Zustand des Verbrauchers bleibt so lange erhalten, bis der nachste EIN- oder AUS-Schaltbefehl erfolgt.

Impuls e Schaltet den Kanal fiir eine kurze Zeit EIN |
Ein Impuls-Schaltbefehl besteht aus: Startzeit !

- Startzeit —— > Impuls- |j«——

— Impulsdauer = EIN-Schaltdauer dauer

15.00h

Zyklus e Schaltet den Kanal iiber eine bestimmte Zeitdauer EIN |
und AUS. Startzeit

e Ein Zyklus-Schaltbefehl besteht aus: -—
Startzeit —»f Impuls- f——

Impulsdauer = EIN-Schaltdauer dauer
Periode = EIN-Schaltdauer + Pause

Zyklusdauer = Zeitspanne zwischen Kanal T ewh L ;9'(‘).71 -

EIN und Kanal AUS |I= ZyKlusdauer JI
Endzeit Kanal EIN Kanal AUS

Periode

Pause

E Die Zyklusdauer darf nicht kleiner als die Periode sein.
Ein Verschachteln von Zyklusprogrammen ist unzuldssig.
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Grafische Darstellung der Schaltbefehle

Schalthefehl

Symbol @ ‘

EIN

AUS

Impuls

Zyklus

2 Schaltbefehle zur selben Zeit

3 oder mehr Schaltbefehle zur selben
Zeit

BN E =

~

Wenn zwei Schaltbefehle zur selben Zeit erfolgen, werden die Symbole

geteilt dargestellt, z. B. A

Wenn drei oder mehr Schaltbefehle zur selben Zeit erfolgen, wird das

Symbol &4 angezeigt.

Klicken Sie mit der rechten Maustaste auf das Symbol i um alle

Schaltbefehle anzuzeigen.

IS 2.,
IMPULS 3.,

Abb. 22: Schaltbefehle

DQ] :*'*-I;
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7.  Schaltprogramme

7.1  Schaltprogramme erstellen

Schaltbefehle werden durch die Schaltflchen [(Enus] [ impuis ] (RF Zyidus
dargestellt.

1. Klicken Sie auf das jeweilige Symbol, um einen Schaltbefehl zu wéhlen.
> Sobald Sie mit dem Mauszeiger (iber die Grafik fahren, &ndert sich dieser
in das gewéhlte Symbol.
2. Klicken Sie mit der linken Maustaste in ein Feld um den EIN-Schaltbefehl zu
platzieren.
Bei einem EIN-/AUS- und Zyklus-Schaltbefehl klicken Sie ein zweites mal in
ein Feld um den AUS-Schaltbefehl zu platzieren.
> Je nach Art des Schaltbefehls offnet sich ein weiteres Einstellungs-
fenster.
Wenn Sie auBerhalb der Grafik klicken wird kein Schaltbefenhl platziert
und Sie miissen das gewiinschte Symbol fiir den Schaltbefehl erneut
wahlen.
3. Um die Start- und Endzeit des Schaltbefehls zu dndern, klicken Sie mit der
linken Maustaste in der Tabelle unter der grafischen Darstellung auf ».
> Es offnet sich ein Pulldown-Menii. Sie kdnnen die Zeit minutengenau
einstellen.

m Ein Schaltprogramm besteht aus mehreren Schaltbefehlen!

24

Schaltbefehle lassen sich auch wie folgt erstellen:

1. Klicken Sie mit der rechten Maustaste an eine beliebige Stelle in der Grafik.
> Es offnet sich ein Auswahlfeld.

2. Klicken Sie auf Neues Programm erstellen und wahlen Sie den
gewiinschten Schaltbefehl.

0900 16:00 | 110 %00 14100 15100 16100  17:00 | 18:00
_l [ Programen]
) Newss Programm erstelien.. 3 I EMJAUS
{inn S

Abb. 23 Neues Schaltprogramm erstellen

3. Klicken Sie mit der linken Maustaste in das gewiinschte Feld in der Grafik
um den Schaltbefehl zu platzieren.

oder

1. Klicken Sie in der Meniileiste auf Bearbeiten - Neues Programm und
wahlen Sie den gewiinschten Schaltbefehl.

[E_} talento dialop plus

| EinfAus
g | ahvssprograrmm | Astrope B Impuls =
CH1 [cH2 [CH3 |CH4 |CHS | CHBLL Zyus

Abb. 24: Neues Schaltprogramm erstellen 2

2. Klicken Sie mit der linken Maustaste in das gewtinschte Feld in der Grafik
um den Schaltbefehl zu platzieren.



7.2 Schaltprogramme loschen

Um ein Schaltprogramm zu ldschen, klicken Sie mit der rechten Maustaste auf
das gew(inschte Schaltprogramm in der Tabelle und wahlen Sie léschen.

JE3ES

Abb. 25: Schaltprogramm ldschen
oder

Klicken Sie mit der rechten Maustaste auf das gewiinschte Schaltprogramm in
der grafischen Darstellung und wéhlen Sie l6schen.

05:00 | 06:00 07:00 08:00 09:00 10:00 11:00 12:00 13:00 14:00

e
i | ENAUSS. » |3 Leschen EmAUS 3 '|

+—— .

Abb. 26: Schaltprogramm Iéschen 2

~

7.3  Schaltprogramm kopieren

Sie konnen ein neues Schaltprogramm auf mehrere Kanéle kopieren. Die Anzahl

der Kanéle ist abhédngig von ihrer Zeitschaltuhr und deren Kanalerweiterungen.

1. Klicken Sie auf das gewiinschte Symbol (EASS | [ mpus ] ojer (RE Zy%us ] fij
den Schaltbefehl.

2. Aktivieren Sie im Feld Programm kopieren die Kanéle, auf die das neue
Schaltprogramm kopiert werden soll.

Programm kopleren
CH1 FCH2 FJCH3 [JCH4 FICH5 FICHE [JCHZ [JCHB

Abb. 27: Schaltprogramm kopieren
> Die gewdhlten Kandle werden mit einem Haken gekennzeichnet.

3. Erstellen Sie Ihr Schaltprogramm.
> Das erstellte Schaltprogramm wird auf alle gewahlten Kandle kopiert.

Wenn Sie nachtréglich ein Schaltprogramm auf einen anderen Kanal

kopieren wollen, klicken Sie doppelt auf das gew(inschte Programm

in der Tabelle und aktivieren Sie anschlieBend die Kandle, auf die das
Schaltprogramm kopiert werden soll.
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7.4  Prioritdt von Schaltprogrammtypen einstellen
Wochen-, Jahres- und Astroprogramme sollten nicht zur gleichen Zeit ablaufen.
Wahlen Sie fiir jeden Schaltprogrammtyp eine andere Prioritét.

Es gibt 10 verschiedene Prioritdts-Level welche Sie beliebig wéhlen konnen.
00 = hochste Prioritat
09 = niedrigste Prioritét

Die Prioritaten sind werkseitig voreingestellt:

Schaltprogrammtyp Prioritdts-Level

- 00 (hdchste Prioritat)
Jahresprogramm/Einzeltag* 03

Jahresprogramm 05

Astroprogramm 05

Wochenprogramm 07

- 09 (niedrigste Prioritat)

RASSLIN

. . YOUR SENSES. OUR SOLUTIONS.
* Jahresprogramm/Einzeltag* sind Jahresschaltprogramme, welche nur an DRSPS T

einem Tag ablaufen (Start- und Enddatum sind identisch).

1. Wihlen Sie in der Mentileiste Optionen = Prioritét einstellen, um die P
Prioritat der Schaltprogrammtypen einzustellen.
> Es o6ffnet sich das Fenster ,Prioritatentabelle”.

2. Wihlen Sie iiber das Pull-Down Menii ® die gewiinschte Prioritat der
einzelnen Schaltprogrammtypen.

3. Klicken Sie auf &1 um die Einstellungen zu speichern.
> Wenn sich Schaltprogramme zeitlich tiberschneiden, wird automatisch

der Schaltprogrammtyp mit der héheren Prioritat gewdahlt und gestartet.

Abb. 28: Prioritédtentabelle
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8.  Wochenprogramm
8.1  Grundlegende Informationen

e FEin Schaltprogramm besteht aus mehreren Schaltbefehlen! Beatotin Crtonn e §
e Das Raster fiir die grafische Darstellung kann liber das Auswahifeld tT e it

Skalierung eingestellt werden. (o ¥ meun | [ 2o | e Satenrg 1 Sk

00 S100 GIU0 (300 B400 DI00 S600 0700 DRG0 9900 K300 1100 1290 AIOD 1400 1590 SE00 1700 MR 1900 00 3100 200 TG0
" (= § s ey —

Skalerung [TSunde &

e Wenn Sie auf ™ in der Tabelle klicken dffnet sich ein Pulldown-Meni.
Hier konnen Sie Zeit, Impulsdauer und Periode minuten- bzw. sekundengenau
einstellen. e : Pt

EENEEN
REER
Ramm

l

. i 3 @ M wm  m M M Do Fr S S0 Tagw
B B® s s o n a a =
- #_ SBR[ BB |2lala] 8
e g# e 00 0Dio0/0lD
s R~ =W =R N ]
“” .r:uﬂr_!E]l']_DEEll'.
s e Al MR Bl Eal = e e
(2] g8 0 0Djoojnia/n|Do
- - | s _siO[oojalofaiolo
) s R CE T CECE #oEE e e B B P BB BB
& InausEm MdwEdswEodmindmEsuEeme 0 0O 0O B BB E D
s s nuwmal w = s & 4 & W WolologlaielElo
|
Abb. 29: Pull-Down Menii
e Um ein Schaltprogramm zu l6schen, klicken Sie mit der rechten Maustaste auf
das gewdiinschte Programm in der Tabelle und wéhlen Sie léschen. i
Abb. 30: Wochenprogramm
m m v, _.._v_l._._l.'.i_v.' vi“ _.v.'l.
Abb. 31: Schaltprogramm Idschen
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8.2  Wochenprogramm — EIN/AUS

Beispiel

Eine Hofbeleuchtung soll automatisch EIN und AUS geschaltet werden:
Montag bis Freitag

05:30 Uhr EIN 08:30 Uhr AUS
17:30 Uhr EIN 21:30 Uhr AUS
Samstag

05:30 Uhr EIN 08:30 Uhr AUS

Am Sonntag bleibt die Hofbeleuchtung AUS.

Programm starten

1. Starten Sie das Programm und wahlen Sie Ihre Zeitschaltuhr.
(Siehe Kapitel 3)
> Es offnet sich das Hauptmenii.

2. Klicken Sie im Register auf die Schaltflaiche Wochenprogramm.

3. Wahlen Sie im Register den Kanal, fiir den das Wochenprogramm erstellt
werden soll, z. B. CH1 = Kanal1

EIN/AUS Programmierung
4. Wahlen Sie den Schaltbefehl [esa),

5. Klicken Sie mit der linken Maustaste in der Zeile fiir Montag auf das Feld
05:30 fiir den ersten EIN-Schaltbefehl und danach in das Feld 08:30 Uhr fiir
den ersten AUS-Schaltbefehl.

Klicken Sie anschlieBend in das Feld 17:30 Uhr fiir den zweiten EIN-

Schaltbefehl und danach in das Feld 21:30 Uhr fiir den zweiten AUS-

Schaltbefehl.

> Das eingegebene Schaltprogramm wird grafisch und tabellarisch
dargestellt.
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Abb. 32: Wochenprogramm - EIN/AUS
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6. Aktivieren Sie in der Tabelle zusétzlich die Wochentage Dienstag bis Samstag

7. Wahlen Sie in der Meniileiste Datei - Speichern, um das Schaltprogramm
zu speichern.
m Wahlen Sie einen geeigneten Namen fiir die Datei, welcher das spatere
Wiederfinden erleichtert. Die Dateiendung muss dabei immer .swp
heiBen!

fiir den ersten EIN- und AUS-Schaltbefehl und die Wochentage Dienstag bis £ el GRASSLIN
N .- . Wocharpug T sbrvmrngame Asbrprogeer
Freitag fiir den zweiten EIN- und AUS-Schaltbefehl. e o e
@ﬁ Eﬁ} o 20 bt
F amm. Wochentage — l:::mmmwnm 30 50 033 13 1030 1199 8130 1200 wnwﬁ\mmmﬂm:‘:m:‘nﬁ:
’ . e AT e et 5 ke . mwEpsiee _ ! v§ o
1 BN B B @B @800 # E Y =
AUS BB =8| @eo o0 " - S> -
2 EN @ e B/ /ool O & A i §
5| = ) . = u ¥
Abb. 34: Wochenprogramm - Tabelle EIN/AUS : """g_. _:j‘:.- s RTR - e oo n.‘:“"‘; e i
> Die Anderungen werden in der grafischen Darstellung Gbernommen. 1 = T o o o e e TN AN
Abb. 35: Wochenprogramm - EIN/AUS 3
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8.3  Wochenprogramm — Impuls

Beispiel

Kanal 1 soll taglich von Montag bis Freitag um 15.00 Uhr EIN geschalten
werden.

Die EIN-Schaltdauer betrdgt 15 Minuten.

Programm starten

1. Starten Sie das Programm und wahlen Sie Ihre Zeitschaltuhr.
(Siehe Kapitel 3)
> Es offnet sich das Hauptmendi.
Klicken Sie im Register auf die Schaltfliche Wochenprogramm.

3. Wahlen Sie im Register den Kanal, fiir den das Wochenprogramm erstellt
werden soll, z. B. CH1 = Kanal1.

Impuls Programmierung

4. Wahlen Sie den Schaltbefehl Ewss],

5. Klicken Sie mit der linken Maustaste in der Zeile fiir Montag auf das Feld
15:00 Uhr fiir den EIN-Schaltbefehl.

> Es offnet sich das Einstellungsfenster fiir die Impulsdauer.
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Abb. 36: Wochenprogramm - Impuls
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6. Stellen Sie Minuten oder Sekunden fiir die Impulsdauer ein und bestétigen
Sie lhre Eingabe mit OK.

Adus-Emnste

Abb. 38: Wochenprogramm - Einstellung Impulsdauer

7. Aktivieren Sie in der Tabelle zusétzlich die Wochentage Dienstag bis Freitag.

Abb. 40: Wochenprogramm - Tabelle Impuls
> Die Anderungen werden in der grafischen Darstellung ibernommen.

8. Wahlen Sie in der Meniileiste Datei = Speichern, um das Schaltprogramm
zu speichern.

E Wahlen Sie einen geeigneten Namen fiir die Datei, welcher das spétere
Wiederfinden erleichtert. Die Dateiendung muss dabei immer .swp
heiBen!

~
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Abb. 41: Wochenprogramm - Impuls 4
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8.4  Wochenprogramm - Zyklus

Beispiel

Kanal 1 wird von Montag 9.00 Uhr an beginnend, jede Stunde fiir 10 Minuten
EIN geschaltet. Endzeit ist Freitag 19.00 Uhr.

Startzeit Montag 9.00 Uhr
Dauer 10 Min.
Periode 1 Std.
Endzeit Freitag 19.00 Uhr

Programm starten

1. Starten Sie das Programm und wahlen Sie Ihre Zeitschaltuhr.
(Siehe Kapitel 3)
> Es 6ffnet sich das Hauptmendi.
Klicken Sie im Register auf die Schaltfliche Wochenprogramm.

3. Wahlen Sie im Register den Kanal, fiir den das Wochenprogramm erstellt
werden soll, z. B. CH1 = Kanal1.

Zyklus Programmierung
4. Wéhlen Sie den Schaltbefehl s,

5. Klicken Sie mit der linken Maustaste in der Zeile fiir Montag auf das Feld
09:00 Uhr fiir den EIN-Schaltbefehl und danach in der Zeile Freitag in das
Feld 19:00 Uhr fiir den AUS-Schaltbefehl.
> Es offnet sich das Einstellungsfenster fiir die Impulsdauer und Periode

des Zyklus.

m Die Impulsdauer darf nicht kleiner als die Periode sein.
Ein Verschachteln von Zyklusprogrammen ist unzuldssig.
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6. Stellen Sie Tage, Stunden, Minuten oder Sekunden fiir die Impulsdauer ein.

|g-:i EBeatenen Cotoren  Hfe GRASSLIN
Impuls-/2yklus-Einstellengen -] = -
:mpulsd_auer : - T e - bRy BRI PR "
IEIJ ][00 {0 o0 & %’%&m 990 0600 G700 0RO 0900 1000 1100 KFOD 130 MO0 1900 1606 1700 R3O 100 mu; o
t hh  mm s :. i ] } Fo
Abb. 45: Wochenprogramm - Impulsdauer b “Em
7. Stellen Sie Tage, Stunden, Minuten oder Sekunden fiir die Periode ein und i
bestatigen Sie Ihre Eingabe mit OK. 5 e ) T I T I S BT T T T
1 s em MErmrMe@wEr s M YN rmEmeE O 0 0 00 OO
Befoia s —
oo | [H ¥ ¥/ ¥
'u TR T Abb. 46: Wochenprogramm - Zyklus 3
Abb. 47: Wochenprogramm - Periode
> Das Schaltprogramm wird grafisch und tabellarisch dargestellt.
8. Wahlen Sie in der Meniileiste Datei = Speichern, um das Schaltprogramm
zu speichern.
E Wahlen Sie einen geeigneten Namen fiir die Datei, welcher das spétere
Wiederfinden erleichtert. Die Dateiendung muss dabei immer .swp
heiBen!
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9. Ferienprogramm

Das Ferienprogramm ist ein Wochenprogramm mit Datumszuweisung. Dieses
gibt es nur bei den Zeitschaltuhren talento 471, 472 plus und talento 671 plus.

Beispiel

Eine Hofbeleuchtung soll in den Sommerferien vom 2. August bis zum 21.
August automatisch EIN und AUS geschaltet werden:

Montag bis Freitag

06:00 Uhr EIN 08:00 Uhr AUS
21:00 Uhr EIN 22:00 Uhr AUS

Am Samstag und Sonntag bleibt die Hofbeleuchtung AUS.

Programm starten

1. Starten Sie das Programm und wahlen Sie Ihre Zeitschaltuhr.
(Siehe Kapitel 3)
> Es o6ffnet sich das Hauptmenti.

2. Wahlen Sie im Register den Kanal, fiir den das Ferienprogramm erstellt
werden soll, z. B. CH1 = Kanal1

3. Aktivieren Sie Ferienprogramm.

EIN/AUS Programmierung

4. Wdhlen Sie den Schaltbefehl [,

5. Klicken Sie mit der linken Maustaste in der Zeile fiir Montag auf das Feld
06:00 fiir den ersten EIN-Schaltbefehl und danach in das Feld 08:00 Uhr fiir
den ersten AUS-Schaltbefehl.

> Es offnet sich das Einstellungsfenster ,Ferien*.

m Bei einem Zyklus- oder Impuls-Schaltbefehl miissen sie zusatzlich die
Impulsdauer und/oder die Periode einstellen.
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6. Stellen Sie das Startdatum (Tag (TT) und Monat (MM)) der Ferien ein.

Ferienbeginn

(2 S[ 8 &
iy MM

Abb. 50: Ferienprogramm - Ferienbeginn

7. Stellen Sie das Enddatum (Tag (TT) und Monat (MM)) der Ferien ein.

Ferienende
2 & 8 2
A MM

Abb. 51: Ferienprogramm - Ferienende

8. Bestitigen Sie Ihre Eingabe mit o],
> Das Schaltprogramm wird grafisch und tabellarisch dargestelit.
9. Klicken Sie anschlieBend in das Feld 21:00 Uhr fiir den zweiten EIN-

Schaltbefehl und danach in das Feld 22:00 Uhr fiir den zweiten AUS-
Schaltbefehl.

> Es o6ffnet sich das Einstellungsfenster ,Ferien*.
10. Stellen Sie Start- und Enddatum der Ferien ein.

> Das eingegebene Schaltprogramm wird grafisch und tabellarisch
dargestellt.
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Abb. 52: Ferienprogramm - EIN/AUS 3
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11. Aktivieren Sie in der Tabelle die Wochentage Montag bis Freitag fiir die EIN-
und AUS-Schaltbefehle.

Abb. 53: Ferienprogramm - Tabelle EIN/AUS
> Die Anderungen werden in der grafischen Darstellung ibernommen.

12. Wahlen Sie in der Meniileiste Datei > Speichern, um das Schaltprogramm
zu speichern.

m Wahlen Sie einen geeigneten Namen fiir die Datei, welcher das spétere

Wiederfinden erleichtert. Die Dateiendung muss dabei immer .swp
heiBen!

» Um das Schaltprogramm zu léschen, klicken Sie mit der rechten Maustaste
auf das gewiinschte Programm in der Tabelle und wéhlen Sie I6schen.

p __hh | mm
L]

EIN ([ goe ¥ 9 4 & 9

Abb. 55: Schaltprogramm Idschen
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10. Jahresprogramm
10.1 Grundlegende Informationen

e FEin Schaltprogramm besteht aus mehreren Schaltbefehlen! i s SRio
o Das Raster fiir die grafische Darstellung kann iiber das Auswahlfeld (Mot s i
Skalierung eingestellt werden. i B T e T e M F T Tt R
Siaterung (1 Swnde 3|
e Wenn Sie auf ¥ in der Tabelle klicken dffnet sich ein Pulldown-Meni.
Hier kdnnen Sie Start- und Endzeit, Impulsdauer und Periode minuten- bzw.
sekundengenau einstellen. o e

Oper gemiitin Tage mm Maerger aswanien

[ T D R | e s mae s P

# TP M osm momm Mmoo ow E M
1 EMEE memen=@e W % = = %
3 IMAUB 15 %00 % 31 = 00 ¥ 00 % 00 % 00 = 00 %00 %

|- - - - - - -

Abb. 55: Pull-Down Menii

e Um das Datum fiir einen EIN/AUS, Impuls- oder Zyklus-Schaltbefehl zu p .
bearbeiten, klicken Sie mit der linken Maustaste zweimal auf das gewiinschte e
Schaltprogramm in der Tabelle und wéhlen Sie ein neues Datum.
Klicken Sie anschlieBend auf [@ememen], um Ihre Einstellungen zu speichern. Abb. 56: Jahresprogramm

e Um ein Schaltprogramm zu léschen, klicken Sie mit der rechten Maustaste auf
das gewunschte Programm in derTabelle und wahlen Sie l6schen.

S]HP'.I.S mvm-wmvnuvonumvmv v_
Abb. 57: Schaltprogramm léschen
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10.2 Jahresprogramm — EIN/AUS

Beispiel 1

Eine Schaufensterbeleuchtung soll vom 1. April bis zum 30. September
automatisch EIN- und AUS geschaltet werden:

Taglich

06:00 Uhr EIN

22:00 Uhr AUS

Programm starten

1. Starten Sie das Programm und wéhlen Sie Ihre Zeitschaltuhr.
(Siehe Kapitel 3)
> Es offnet sich das Hauptmend.

2. Klicken Sie im Register auf die Schaltfldche Jahresprogramm.

3. Waéhlen Sie im Register den Kanal, fiir den das Jahresprogramm erstellt
werden soll, z. B. CH1 = Kanal1.

EIN/AUS Programmierung
4. Wahlen Sie den Schaltbefehl Cena,

5. Klicken Sie mit der linken Maustaste in der Zeile fiir den Kanal 1 (CH1) auf
das Feld 06:00 Uhr fiir den EIN-Schaltbefehl und danach in das Feld 22:00
Uhr fiir den AUS-Schaltbefehl.

6. Klicken Sie mit der linken Maustaste auf den 1. April im Kalender und danach
mit gedriickter ,Shift-Taste" auf den 30. September.
oder
Klicken Sie mit der linken Maustaste auf den 1. April im Kalender und halten

Sie die Maustaste gedriickt. Fahren Sie mit dem Mauszeiger anschlieBend
auf den 30. September und lassen Sie die Taste los.

> Die gewdhlten Tage werden weiB hinterlegt und fett dargestellt.
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7. Klicken Sie auf [Geemenmen | um Ihre Einstellungen zu ibernehmen.
> Es o6ffnet sich das Fenster ,,Programm wéhlen*.

8. Wahlen Sie, ob das Schaltprogramm nur fiir das gewahite Jahr (Einmalig)
oder jedes Jahr (Wiederkehrend) ausgefiihrt werden soll.

Abb. 60: Jahresprogramm - Programm wéhlen
> Das Schaltprogramm wird grafisch und tabellarisch dargestelit.

» Um das Datum fiir den EIN-/AUS-Schaltbefehl zu bearbeiten, klicken Sie mit
der linken Maustaste zweimal auf das gewiinschte Schaltprogramm in der
Tabelle und wahlen Sie ein neues Datum.

Klicken Sie anschlieBend auf [Gemenmen | um Ihre Einstellungen zu speichern.

Ubernehmen
Abbrechen Feiertage
Oder gewlinschte Tage im Kalender auswahlen
Programm | Startzeit | Endzeit |  Impulsdauer | Pe

# | hh | mm | hh

mm | hh | mm  ss
EIN AUS 1

Abb. 61: Jahresprogramm - Tabelle EIN/AUS
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Schaltprogramm fiir Feiertage

4,
5.
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Wahlen Sie den Schaltbefehl Cen),

Klicken Sie mit der linken Maustaste in der Zeile fir den Kanal auf das
gewdnschte Feld fiir den EIN-Schaltbefehl und danach in das Feld fiir den
AUS-Schaltbefehl.

Klicken Sie auf ["Feet=pe 1 um die Feiertage auszuwahlen.

> Es offnet sich das Einstellungsfenster ,Feiertage*.

Klicken Sie auf Land und wéhlen Sie das entsprechende Land.

LandRegion
| Dautschland BadesrWirttemsberg

(Coshh Rupublica
Deutuchisnd Brandenbury
wchlsnd Buysm
| Deutschiand Bremen -
Abb. 62: Jahresprogramm - Auswahl Land
> Unter Feiertage werden die Feiertage des jeweiligen Landes gelistet.

Klicken Sie mit der linken Maustaste in die erste Tabellenspalte um den
gewlinschten Feiertag zu wahlen.

Fenntage

Mame Drate (dd mm.yy) -
Meujstentsg 01.01.200 |
 Hulign i Knige 106.01.2010

Karkwitag 0204200

 Catermonisg 05.04.2010

Tog dor Arba 01052010 |
Christi Himmifahet 13.05.2010 =

[ ] [k | [ o) [Cree ]
Abb. 64: Jahresprogramm - Auswahl Feiertage

Klicken Sie auf C_# ], um alle Feiertage auszuwahlen.
Klicken Sie auf (¥ ] um alle Feiertage abzuwahlen.

GRASSLIN

YOUR SENSES. OUR SOLUTIONS.

LandRagion
Feietage

MName Diate (. rren ) -8

gt o010 o]

Helige Drei Kzeige 06.01.2010

Karkeitag 02042010

| Ostervantag 05042010

Tog e Acben LT ]

Cheiati Himenelfshet 13052010 L

] [Cre= ]

[ ) [Creee ] [

Abb. 63 Jahresprogramm - Einstellungsfenster Feiertage



» Klicken Sie auf (=== um alle Feiertage auszuwahlen, welche ein
bewegliches Datum haben, z. B. Ostern.

» Klicken Sie auf [F=="1, um alle Feiertage auszuwahlen, welche ein festes
Datum haben, z. B. Weihnachten.

9. Bestétigen Sie Ihre Eingabe mit OK.
> Die Feiertage werden im Kalender fett dargestellt.

10. Klicken Sie auf [Guemenmen ] ym |hre Einstellungen zu ibernehmen.
> Es offnet sich das Fenster ,Programm wahlen®.

11. Wéhlen Sie, ob das Schaltprogramm nur fiir das gewahlte Jahr (Einmalig)
oder jedes Jahr (Wiederkehrend) ausgefiihrt werden soll.

Abb. 65: Jahresprogramm - Programm wéhlen
> Das Schaltprogramm wird grafisch und tabellarisch dargestellt.

E Wenn Feiertage mit beweglichem Datum gewahlt werden, 6ffnet sich bei
der Auswahl ,Wiederkehrend“ das Fenster ,,Berechnung der beweglichen
Feiertage“.

Bitte wahlen Sie das Jahr bis zu welchem die beweglichen Feiertage
berechnet werden soen.

MEGI | [ o |l J

Abb. 66: Jahresprogramm - Berechnung der beweglichen Feiertage

Stellen Sie ein, bis zu welchem Jahr die beweglichen Feiertage berechnet

werden sollen und bestétigen Sie lhre Eingabe mit OK.

~

Jahresiibergreifendes Schaltprogramm

Eine Schaufensterbeleuchtung soll vom 1. April 2010 bis zum 30. Mérz 2011
automatisch EIN- und AUS geschaltet werden:

Taglich

06:00 Uhr EIN 22:00 Uhr AUS

4. Wahlen Sie den Schaltbefeh! Cemm,

5. Klicken Sie mit der linken Maustaste in der Zeile fiir den Kanal auf das Feld
6:00 Uhr fiir den EIN-Schaltbefehl und danach in das Feld 22:00 Uhr fiir den
AUS-Schaltbefehl.

6. Klicken Sie mit der linken Maustaste auf den 1. April 2010 im Kalender und
danach mit gedriickter ,Shift-Taste* auf den 31. Dezember 2010.

7. Wihlen Sie das Jahr 2011 s [ @12

8. Klicken Sie mit der linken Maustaste auf den 1. Januar 2011 im Kalender
und danach mit gedriickter ,Shift-Taste“ auf den 30. Marz 2011.

9. Klicken Sie auf [Geemenmen] ym Ihre Einstellungen zu speichern.

. Wahlen Sie, ob das Schaltprogramm nur fiir das gewéhlte Jahr (Einmalig)

oder jedes Jahr (Wiederkehrend) ausgefiihrt werden soll.
> Das Schaltprogramm wird grafisch und tabellarisch dargestellt.

_
o
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10.3 Jahresprogramm — Impuls

Beispiel

Kanal 1 soll taglich vom 1. Juli bis 30. Oktober um 15.00 Uhr EIN geschalten
werden.
Die EIN-Schaltdauer betrdgt 15 Minuten.

Programm starten

1. Starten Sie das Programm und wahlen Sie Ihre Zeitschaltuhr.
(Siehe Kapitel 3)
> Es offnet sich das Hauptmend.
Klicken Sie im Register auf die Schaltfliche Jahresprogramm.

3. Wahlen Sie im Register den Kanal, fiir den das Jahresprogramm erstellt
werden soll, z. B. CH1 = Kanal1.

Impuls Programmierung
4. Wahlen Sie den Schaltbefehl s,

5. Klicken Sie mit der linken Maustaste in der Zeile fiir Kanal 1 (CH1) auf das
Feld 15:00 Uhr fiir den EIN-Schaltbefehl.

> Es 6ffnet sich das Einstellungsfenster fiir die Impulsdauer.

6. Stellen Sie Minuten oder Sekunden fiir die Impulsdauer ein und bestétigen
Sie ihre Eingabe mit OK.

42 Abb. 69: Jahresprogramm - Impulsdauer
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7. Klicken Sie mit der linken Maustaste auf den 1. Juli im Kalender und danach
mit gedriickter ,Shift-Taste“ auf den 30. Oktober.
oder
Klicken Sie mit der linken Maustaste auf den 1. Juli im Kalender und halten
Sie die Maustaste gedrtickt. Fahren Sie mit dem Mauszeiger anschlieBend
auf den 30. Oktober und lassen Sie die Taste los.
> Die gewahiten Tage werden weiB hinterlegt und fett dargestellt.

8. Klicken Sie auf [Geemenmen | um Ihre Einstellungen zu ibernehmen.
> Es offnet sich das Fenster ,Programm wahlen®.

9. Wahlen Sie, ob das Schaltprogramm nur fiir das gewahite Jahr (Einmalig)
oder jedes Jahr (Wiederkehrend) ausgefiihrt werden soll.

Abb. 72 Jahresprogramm - Programm wéhlen
> Das Schaltprogramm wird grafisch und tabellarisch dargestellt.

» Um das Datum fiir den Impuls-Schaltbefehl zu bearbeiten, klicken Sie mit
der linken Maustaste zweimal auf das gewiinschte Schaltprogramm in der
Tabelle und wéhlen Sie ein neues Datum.

Klicken Sie anschlieBend auf [Gemenmen | um Ihre Einstellungen zu speichern.

Abb. 70: Jahresprogramm - Impuls

| Impulsdauer | Pt

BT

Programm | Startzeit | Endzeit
' hh | mm | hh  mm |

| VEUEEE - G5 ~ REX - BN - IG5 - REY ~ Y |

{Enht [fmmit| sst |t [Ehh

Abb. 71: Jahresprogramm - Tabelle Impuls
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Schaltprogramm fiir Feiertage

4,
5.
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Wahlen Sie den Schaltbefehl G,

Klicken Sie mit der linken Maustaste in der Zeile fiir den Kanal auf das
gewiinschte Feld fiir den EIN-Schaltbefehl.

> Es 6ffnet sich das Einstellungsfenster fiir die Impulsdauer.

Stellen Sie Minuten oder Sekunden fiir die Impulsdauer ein und bestétigen
Sie ihre Eingabe mit OK.

Klicken Sie auf [_Feesge ], um die Feiertage auszuwahlen.

> Es offnet sich das Einstellungsfenster ,Feiertage*.

Klicken Sie auf Land und wéhlen Sie das entsprechende Land.

LandRegion
| Dautschland BadesrWirttemsberg

Cosich Republica
Danmark
Doutschiaad Bransenburg

schlsadd Bayem
| Deutschiand Bremen -
Abb. 73 Jahresprogramm - Auswahl Land
> Unter Feiertage werden die Feiertage des jeweiligen Landes gelistet.

Klicken Sie mit der linken Maustaste in die erste Tabellenspalte um den
gew(inschten Feiertag zu wéhlen.

Favmtage

Mamea Drate (dd mm.y) - &
Huujshrrtag 01.01.2010
 Hulign i Knige 106.01.2010

Karkwitag 0204200

 Catermonisg 05.04.2010

Tog dor Arba 01052010 |
Christi Himmifahet 13.05.2010 =

[Cae ) e ] [ ] [Cree )
Abb. 75: Jahresprogramm - Auswahl Feiertage

Klicken Sie auf C_# ], um alle Feiertage auszuwahlen.

GRASSLIN

YOUR SENSES. OUR SOLUTIONS.

LandRagion
Feietage

MName Diate (. rren ) -8

gt o010 o]

Helige Drei Kzeige 06.01.2010

Karkeitag 02042010

| Ostervantag 05042010

[Tog dor Febad 10152010 |

Cheiati Himenelfshet 13052010 L

] [Cre= ]

[ ) [Creee ] [

Abb. 74: Jahresprogramm - Einstellungsfenster Feiertage



10.

1

—_

12.

Klicken Sie auf %= "] um alle Feiertage abzuwahlen.

Klicken Sie auf [e====] um alle Feiertage auszuwéhlen, welche ein
bewegliches Datum haben, z. B. Ostern.

Klicken Sie auf ["re= ] um alle Feiertage auszuwahlen, welche ein festes
Datum haben, z. B. Weihnachten.

Bestétigen Sie Ihre Eingabe mit OK.

> Die Feiertage werden im Kalender fett dargestellt.

. Klicken Sie auf [Geemenmen | ym Ihre Einstellungen zu ibernehmen.

> Es offnet sich das Fenster ,Programm wahlen®.

Wahlen Sie, ob das Schaltprogramm nur fir das gewahlte Jahr (Einmalig)
oder jedes Jahr (Wiederkehrend) ausgefiihrt werden soll.

Abb. 76: Jahresprogramm - Programm wéhlen
> Das Schaltprogramm wird grafisch und tabellarisch dargestellt.

Wenn Feiertage mit beweglichem Datum gewahlt werden, 6ffnet sich bei
der Auswahl ,Wiederkehrend“ das Fenster ,,Berechnung der beweglichen
Feiertage“.

Bitte wahlen Sie das Jahr bis zu welchem die beweglichen Feiertage
berechnet werden soen.

w0 3

[« J

Abb. 77: Jahresprogramm - Berechnung der beweglichen Feiertage

Stellen Sie ein, bis zu welchem Jahr die beweglichen Feiertage berechnet
werden sollen und bestétigen Sie lhre Eingabe mit OK.

Jahresiibergreifendes Schaltprogramm

Kanal 1 soll taglich vom 1. April 2010 bis 30. Méarz um 15.00 Uhr EIN
geschalten werden.
Die EIN-Schaltdauer betrdgt 15 Minuten.

4. Wihlen Sie den Schaltbefehl ez,

5. Klicken Sie mit der linken Maustaste in der Zeile fiir Kanal 1 (CH1) auf das
Feld 15:00 Uhr fiir den EIN-Schaltbefehl.

> Es offnet sich das Einstellungsfenster fiir die Impulsdauer.

6. Stellen Sie Stunden, Minuten oder Sekunden fiir die Impulsdauer ein und
bestétigen Sie ihre Eingabe mit OK.

7. Klicken Sie mit der linken Maustaste auf den 1. April 2010 im Kalender und
danach mit gedriickter ,Shift-Taste* auf den 31. Dezember 2010.

8. Wihlen Sie das Jahr 2011 s [ @112

9. Klicken Sie mit der linken Maustaste auf den 1. Januar 2011 im Kalender
und danach mit gedriickter ,Shift-Taste* auf den 30. Marz 2011.

10. Klicken Sie auf [Gremenmen] um |hre Einstellungen zu speichern.

11. Wihlen Sie, ob das Schaltprogramm nur fiir das gewahlte Jahr (Einmalig)
oder jedes Jahr (Wiederkehrend) ausgefiihrt werden soll.
> Das Schaltprogramm wird grafisch und tabellarisch dargestellt.
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10.4 Jahresprogramm — Zyklus

Beispiel

Kanal 1 wird vom 15. Januar bis 15. April, jede Stunde fiir 10 Minuten EIN
geschaltet.

Startzeit Montag 15. Januar, 9.00 Uhr
Dauer 10 Min.

Periode 1 Std.

Endzeit Freitag 15. April, 19.00 Uhr

Programm starten

1. Starten Sie das Programm und wéhlen Sie Ihre Zeitschaltuhr.
(Siehe Kapitel 3)

> Es 6ffnet sich das Hauptmendi.
Klicken Sie im Register auf die Schaltfliche Jahresprogramm.

3. Wahlen Sie im Register den Kanal, fiir den das Jahresprogramm erstellt
werden soll, z. B. CH1 = Kanal1.

Zyklus Programmierung
4. Wéhlen Sie den Schaltbefehl s,

5. Klicken Sie mit der linken Maustaste in der Zeile fiir den Kanal 1 (CH1) auf

das Feld 09:00 Uhr fiir den EIN-Schaltbefehl und danach in das Feld 19:00
Uhr fiir den AUS-Schaltbefehl.

> Es 6ffnet sich das Einstellungsfenster fiir die Impulsdauer und Periode
des Zyklus.

m Die Impulsdauer darf nicht kleiner als die Periode sein.
Ein Verschachteln von Zyklusprogrammen ist unzuldssig.
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6. Stellen Sie Tage, Stunden, Minuten oder Sekunden fiir die Impulsdauer ein.

Impuls-/ Zyklus-Einstellsngen

Impulsdaver = =
o0 v/joo w0 vjo0 v
it hh mm 5%

Abb. 80: Jahresprogramm - Impulsdauer

7. Stellen Sie Tage, Stunden, Minuten oder Sekunden fiir die Periode ein und
bestatigen Sie Ihre Eingabe mit OK.
Periods
o BN o Sl 8
t hh mm 55

o] [rommr ]

Abb. 81: Jahresprogramm - Periode

8. Klicken Sie mit der linken Maustaste auf den 15. Januar im Kalender und
danach mit gedriickter ,Shift-Taste“ auf den 15. April.
oder
Klicken Sie mit der linken Maustaste auf den 15. Januar im Kalender
und halten Sie die Maustaste gedriickt. Fahren Sie mit dem Mauszeiger
anschlieBend auf den 15. April und lassen Sie die Taste los.
> Die gewéhlten Tage werden weiB hinterlegt.

Abb. 82: Jahresprogramm - Impuls

[Dsemermen |

[Cissrecmen | [ Fomrinn ]

ter gemnscn Tage e el murmatien.
Tourt g

o
moem e momm w8 m

Programm | Starizeit | Endzeit

| Impulsdaver |

Per

# y hh | mm  hh

'mm | hn | mm | ss

Abb. 83: Jahresprogramm - Tabelle Impuls
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9. Klicken Sie auf [Gzemenmen] um Ihre Einstellungen zu ibernehmen.
> Es offnet sich das Fenster ,Programm wéhlen®.

10. Wahlen Sie, ob das Schaltprogramm nur fiir das gewahlte Jahr (Einmalig)
oder jedes Jahr (Wiederkehrend) ausgefiihrt werden soll.

Abb. 84: Jahresprogramm - Programm wéhlen
> Das Schaltprogramm wird grafisch und tabellarisch dargestellt.

» Um das Datum fiir den Zyklus-Schaltbefehl zu bearbeiten, klicken Sie mit
der linken Maustaste zweimal auf das gew(inschte Schaltprogramm in der
Tabelle und wahlen Sie ein neues Datum.

Klicken Sie anschlieBend auf [Geemenmen], um Ihre Einstellungen zu
tibernehmen.
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Schaltprogramm fiir Feiertage

4,
5.

Wahlen Sie den Schaltbefehl Eass],

Klicken Sie mit der linken Maustaste in der Zeile fiir den Kanal auf das

gewiinschte Feld fiir den EIN-Schaltbefehl und danach in das Feld fiir den

AUS-Schaltbefehl.

> Es offnet sich das Einstellungsfenster fiir die Impulsdauer und Periode
des Zyklus.

Stellen Sie Stunden, Minuten oder Sekunden fiir die Impulsdauer ein.

Stellen Sie Tage, Stunden, Minuten oder Sekunden fiir die Periode ein und
bestatigen Sie ihre Eingabe mit OK.

Klicken Sie auf [Feewse 1 um die Feiertage auszuwahlen.

> Es o6ffnet sich das Einstellungsfenster ,Feiertage*.

Klicken Sie auf Land und wéhlen Sie das entsprechende Land.

LandRegion
| Dautschland BadesrWirttemsberg

Cosich Frapublica
[Deutschisnd Brandentury
nchlsnd Bayem
[Dewtschiand Bremen e
Abb. 85: Jahresprogramm - Auswahl Land
> Unter Feiertage werden die Feiertage des jeweiligen Landes gelistet.

GRASSLIN

YOUR SENSES. OUR SOLUTIONS.

LandRagion
Feietage
MName Diate (. rren ) - &
gt o010 o]
Helige Drei Kzeige 06.01.2010
Karkeitag 02042010
| Ostervantag 05042010
Tog e Acben LT ]
Cheiati Himenelfshet 13052010 =

] [Cre= ]

[ ) [Creee |

Abb. 86: Jahresprogramm - Einstellungsfenster Feiertage
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Klicken Sie mit der linken Maustaste in die erste Tabellenspalte um den
gew(inschten Feiertag zu wéhlen.
Fonontage
Mame Drate (dd mm.yy) -
Miujahritig 01.01.200
| Hulige Orei Kamige 06,0120
arkutag 020420
 Catermonisg 05.04.2010
Tag dar Arsed 035200 |
Chaists Himerwtiaht 13052010 -
o ) [Creme ] [ ] [Cre= )

Abb. 87: Jahresprogramm - Auswahl Feiertage

Klicken Sie auf C_# ], um alle Feiertage auszuwahlen.

Klicken Sie auf (¥ ] um alle Feiertage abzuwahlen.

Klicken Sie auf [s==sm| um alle Feiertage auszuwahlen, welche ein
bewegliches Datum haben, z. B. Ostern.

Klicken Sie auf [_F== ], um alle Feiertage auszuwahlen, welche ein festes
Datum haben, z. B. Weihnachten.

. Bestatigen Sie Ihre Eingabe mit OK.

> Die Feiertage werden im Kalender fett dargestellt.

Klicken Sie auf [Geemenmen | um |hre Einstellungen zu {ibernehmen.
> Es offnet sich das Fenster ,Programm wéhlen®.

Wahlen Sie, ob das Schaltprogramm nur fiir das gewahlite Jahr (Einmalig)
oder jedes Jahr (Wiederkehrend) ausgefiihrt werden soll.

Abb. 89: Jahresprogramm - Programm wéhlen
> Das Schaltprogramm wird grafisch und tabellarisch dargestellt.

m Wenn Feiertage mit beweglichem Datum gewéhit werden, 6ffnet sich bei

der Auswahl ,Wiederkehrend“ das Fenster ,Berechnung der beweglichen
Feiertage“.

Berec

Bitte wahlen Sie das Jahr bis zu welchem die beweglichen Feiertage
berechnet werden soen.

I [ oK |[ Avbrechen |

Abb. 88: Jahresprogramm - Berechnung der beweglichen Feiertage

Stellen Sie ein, bis zu welchem Jahr die beweglichen Feiertage berechnet
werden sollen und bestétigen Sie Ihre Eingabe mit OK.



Jahresiibergreifendes Schaltprogramm

Kanal 1 wird vom 1. April 2010 bis zum 30. Marz 2011 jede Stunde fiir 10
Minuten EIN geschaltet.

Startzeit Montag 1. April 2010, 9.00 Uhr
Dauer 10 Min.

Periode 1 Std.

Endzeit Freitag 30. Mérz 2011, 19.00 Uhr

4. Wahlen Sie den Schaltbefehl Ezss),

5. Klicken Sie mit der linken Maustaste in der Zeile fiir den Kanal 1 (CH1) auf
das Feld 09:00 Uhr fiir den EIN-Schaltbefehl und danach in das Feld 19:00
Uhr fiir den AUS-Schaltbefehl.
> Es o6ffnet sich das Einstellungsfenster fiir die Impulsdauer und Periode

des Zyklus.

6. Stellen Sie Stunden, Minuten oder Sekunden fiir die Impulsdauer ein.

7. Stellen Sie Tage, Stunden, Minuten oder Sekunden fiir die Periode ein und
bestatigen Sie Ihre Eingabe mit OK.

8. Klicken Sie mit der linken Maustaste auf den 1. April 2010 im Kalender und
danach mit gedriickter ,Shift-Taste“ auf den 31. Dezember 2010.

9. Waéhlen Sie das Jahr 2011 Jane | 2n 2

10. Klicken Sie mit der linken Maustaste auf den 1. Januar 2011 im Kalender
und danach mit gedriickter ,,Shift-Taste“ auf den 30. Mérz 2011.

11. Klicken Sie auf [Geemenmen | ym |hre Einstellungen zu speichern.

12. Wéhlen Sie, ob das Schaltprogramm nur fiir das gewahlte Jahr (Einmalig)
oder jedes Jahr (Wiederkehrend) ausgefiihrt werden soll.
> Das Schaltprogramm wird grafisch und tabellarisch dargestellt.
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11. Astroprogramm

Das Astroprogramm berechnet nach Eingabe der Koordinaten lhres
Standortes (L&nge/Breite) automatisch die tdglichen Sonnenauf- bzw.
Sonnenuntergangszeiten.

o EIN-Befehl bei Sonnenuntergang.
o AUS-Befenhl bei Sonnenaufgang.

Beispiel

Eine Schaufensterbeleuchtung soll, abhdngig von den Sonnenauf- bzw.
Sonnenuntergangszeiten, vom 01. April bis zum 30. September automatisch
EIN und AUS geschaltet werden.

Sonnenaufgang = Licht AUS
Sonnenuntergang = Licht EIN

Programm starten:

1. Starten Sie das Programm und wahlen Sie Ihre Zeitschaltuhr.
(Siehe Kapitel 3)
> Es 6ffnet sich das Hauptmendi.

2. Klicken Sie im Register auf die Schaltfliche Astroprogramm.

3. Wahlen Sie im Register den Kanal, fiir den das Astroprogramm erstellt
werden soll, z. B. CH1 = Kanal1.
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m Wenn Sie ein Astroprogramm erstellen und speichern, wird dieses
automatisch in ein Jahresprogramm umgewandelt.

Wird ein Astroprogramm erneut gedffnet, sind die einzelnen Schaltbefehle
im Jahresprogramm aufgefiihrt. Eine Anderungen der EIN- und AUS-
Schaltzeiten ist mdglich.
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Abb. 90: Astroprogramm



Standort / Zeitzone

Fiir das Berechnen der Schaltzeiten fir Inren Standort sind die jeweiligen
geographischen Koordinaten und die Zeitzone erforderlich. Ihr Standort wird
in Langen- und Breitengraden angegeben. Je genauer Sie lhren Standort
bestimmen, desto genauer erfolgen die Schaltzeiten.
4. Klicken Sie auf Land und wéhlen Sie lhr Land.

Standort
Land/Region
|F SR

Abb. 91: Astroprogramm - Land

5. Klicken Sie auf Stadt und wahlen Sie Ihre Stadt.

Standort | VillingenSchwenringen »
Land/Region ] =
| Deutschland v |[Oldenburg
L 0 |losnabrock

Rostock

Stutigan
sradt = -
VillingenSchwenningen

Abb. 92: Astroprogramm - Stadt

> Die Langen- und Breitengrade werden automatisch im Feld
,Koordinaten“ eingetragen.
Die Zeitzone wird automatisch im Feld , Zeitzone“ eingetragen.

m Koordinaten konnen auch manuell eingegeben werden:

Breitengrad: + fiir Nord
— fiir Stid
Léngengrad: + fiir Ost
— fiir West
Koordinaten
G g R E
8 floo |*fe [*joo |
Zeitzone
i@

Abb. 93: Astroprogramm - Koordinaten

Standort
Land/Region

D

Stadt

iy
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Sommer-/Winterzeitumstellung
Folgende Einstellungen sind méglich:

AUTO
Werksseitig Voreinstellung der gesetzlichen Vorgabe (USA oder EU). Diese wird
jedes Jahr neu berechnet.

NEIN
Keine Umstellung.

ANPASSEN 2
Manuelle Programmierung.
Die Umschaltung erfolgt jedes Jahr immer am gleichen eingegebenen Datum.

Datumsbereich

Hier geben Sie an in welchem Zeitraum das Astroprogramm ausgeftihrt wird.
Bei Klicken auf das jeweilige Pull-Down Menii erscheint ein Kalender. Wéhlen Sie
Start- und Enddatum.

Intervall

Sie konnen eine Intervallszeit festlegen, in welcher die EIN und AUS-Schaltzeiten
des Astroprogramms ,,gemittelt” werden.

Innerhalb dieses Zeitraumes — z. B. Intervall = 10 Tage — werden die
Schaltbefehle bei Sonnenauf- bzw. Sonnenuntergang immer zum gleichen
Zeitpunkt ausgefiihrt.
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) Auto  (nur glltig fr Europa und USA) O Anpassen 2 Start
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Abb. 94: Astroprogramm - Sommer-/Winterzeitumstellung

Datumsbereich
Auswahl gilt auch fir die folgenden Jahre

Bl apiizone [E
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19 2021 22 23 24 25
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Abb. 95: Astroprogramm - Datumsbereich
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Nachtabschaltung
Hier kénnen Sie einstellen in welchem Zeitraum die Zeitschaltuhr ausschalten
soll, z. B. Nachtabschaltung von 23 - 5 Uhr.
» Aktivieren Sie Anpassen und stellen Sie die gewiinschten AUS- und EIN-
Schaltzeiten ein.
Beispiel Schaufensterbeleuchtung:
— Licht AUS bei Sonnenaufgang
— Licht EIN bei Sonnenuntergang
— Nachtabschaltung von 23 - 5 Uhr.

23 Uhr Sonnenaufgang
1
EIN AUS EIN AUS
........ il [
Sonnenuntergang 5 Uhr

» Deaktivieren Sie EIN, wenn die Nachtabschaltung bis zum nichsten
Sonnenuntergang andauern soll.
Beispiel Schaufensterbeleuchtung:

— Licht EIN bei Sonnenuntergang
— Nachtabschaltung ab 23 Uhr.

23 Uhr 23 Uhr
1
EIN AUS EIN AUS
....... i [
Sonnenuntergang Sonnenuntergang

Nachtabschaltung
O Keine
—©) Anpassen
hh  mm
Aus 23 £ 00§

=] Ein

a3

|
R

Abb. 96: Astroprogramm - Nachtabschaltung
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Offset

Mit Offset kdnnen Sie die EIN- bzw. AUS-Schaltzeiten des Astroprogramms
verschieben. Dies dient u.a. der Anpassung an ortliche Gegebenheiten.

Beispiel:

Kanal 1 (CH1) soll

e Erst 45 Minuten nach dem berechneten Sonnenaufgang AUS schalten.
Offset = + 00:45

e Bereits 1 Stunde 15 Minuten vor dem berechneten Sonnenuntergang EIN
schalten.
Offset = - 01:15

Schaltzustand

Hier kdnnen Sie einstellen welcher Schaltbefehl bei Sonnenauf- bzw.
Sonnenuntergang ausgefiihrt werden soll.

Wahlen Sie zwischen folgenden Schaltbefehlen:

AUS Die Zeitschaltuhr schaltet bei Sonnenaufgang AUS,
bei Sonnenuntergang EIN.
EIN Die Zeitschaltuhr schaltet bei Sonnenaufgang EIN,

bei Sonnenuntergang AUS.

IMPULS Die Zeitschaltuhr schaltet bei Sonnenauf- und
Sonnenuntergang fiir die eingestellte Zeit EIN (Impuls).
Maximale Impuls-Schaltdauer 1 Std., 59 Min., 59 Sek.

KEIN Bei Sonnenaufgang wird kein Schaltbefehl ausgefiihrt.

flir den Impuls-Schaltbefehl.

Fiir den Sonnenuntergang offnet sich automatisch das Fenster
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Abb. 97: Astroprogramm - Offset

Programm
Sonnenaufgang

AUS -
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Abb. 98: Astroprogramm - Schaltzustand



Astroprogramm (ibernehmen / léschen
1. Klicken Sie auf um das Astroprogramm zu tibernehmen.
> Das Schaltprogramm wird in der Tabelle angezeigt.

2. Wéhlen Sie in der Meniileiste Datei = Speichern, um das Schaltprogramm
zu speichern.

» Um ein Astroprogramm zu l6schen, klicken Sie auf das gewtinschte
Programm in der Tabelle und anschlieBend auf ["tesehen ],

oder

Klicken Sie mit der rechten Maustaste auf das gewiinschte Astroprogramm in
der Tabelle und wéhlen Sie l6schen.

Abb. 99: Astroprogramm léschen

» Um ein Astroprogramm zu bearbeiten, klicken Sie mit der linken Maustaste
zweimal auf das gewiinschte Programm in der Tabelle.

m Wenn Sie ein Astroprogramm speichern, wird dieses automatisch in ein
Jahresprogramm umgewandelt.
Wird das Astroprogramm erneut gedffnet, sind die einzelnen Schaltbefehle
im Jahresprogramm aufgefiihrt. Eine Anderungen der EIN- und AUS-
Schaltzeiten ist mdglich.

Prgrarses woperen
o1 CeHT

Abb. 100: Astroprogramm




12. Schaltprogramme via LAN-Modul iibertragen
12.1  Prinzip der Ubertragung

Ein mit der Software talento dialog plus am PC erstelltes Schaltprogramm kann
(iber ein LAN-Netzwerk oder das Internet auf das LAN-Modul iibertragen werden,
um dann via Powerline an die Jahreszeitschaltuhr tibermittelt zu werden.

Ebenso kénnen Programme von der Zeitschaltuhr (iber das LAN-Modul auf den
PC importiert werden.

Ein LAN-Modul kann jeweils nur mit einer Zeitschaltuhr synchronisiert werden!

12.2 LAN-Modul — Einstellungen

Bevor Sie Daten (iber das LAN-Modul an die Zeitschaltuhr senden bzw.

Daten aus der Zeitschaltuhr auslesen, missen Sie das LAN-Modul in der 2.

Software ,talento dialog plus“ konfigurieren!

1. Wdhlen Sie in der Meniileiste Optionen - Einstellungen > talento LAN
plus, um Einstellungen fiir das LAN-Modul (talento LAN plus) vorzunehmen.
> Es offnet sich das Fenster ,Einstellungen®.

m Mit der Software kénnen Sie insgesamt 10 Arbeitsgruppen mit jeweils bis
zu 10 LAN-Modulen verwalten.

2. Klicken Sie auf [Enseiingen | um die entsprechende Arbeitsgruppe einzustellen.
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YOUR SENSES. DUR SOLUTIONS.

Einstellungen

Arbetsgrppe | Heme | lm
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Arboitsgnppad m —Em igen |
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Abb. 101: Schaltprogramme (ibertragen — LAN-Modul Einstellungen



Geben Sie einen Namen fiir lhre Arbeitsgruppe ein, z. B. LAN-Module
Gebaude A.

. Wenn sich LAN-Modul und PC im selben lokalen Netzwerk befinden,
aktivieren Sie das Feld LAN Netzwerk & usivemes

Klicken Sie anschlieBend auf [ tassasssia ] um bereits vorhandene LAN-
Module im Netzwerk zu suchen (siehe Seite 60, ,LAN-Module im Netzwerk
suchen®).

oder

Deaktivieren Sie das Feld LAN Netzwerk Cwwhemwe  wenn Sie (iber das
Internet auf das LAN-Modul zugreifen,

IP-Adresse, TCP-Port und HTTP-Port werden automatisch vom Grésslin-
Server zugeteilt.

Alle Parameter konnen auch manuell in die Tabelle eingegeben werden:
— Name der Installation, z. B. LAN-Modul 1

— Seriennummer und MAC Adresse des LAN-Moduls

— IP-Adresse (Nur aktiv wenn Sie LAN Netzwerk aktiviert haben)

— TCP-Port (Nur aktiv wenn Sie LAN Netzwerk aktiviert haben)

— HTTP-Port (Nur aktiv wenn Sie LAN Netzwerk aktiviert haben)

Die Spalte ,Internetzugang“ wird automatisch ausgefillt.
Klicken Sie mit der linken Maustaste doppelt auf web um die Startseite des
Administrationsbereich des LAN-Moduls zu 6ffnen.

Klicken Sie auf === um lhre Einstellungen zu speichern.

Klicken Sie auf (=&, um die Seite ohne speichern der Einstellungen zu
verlassen.

Klicken Sie auf [Emwmw s | um den Internetzugang zu konfigurieren
(siehe Seite 61, ,Erweiterte Einstellungen®).

(ry
YOUR SENSES. OUR SOLUTIONS.

Einstellungen
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Abb. 102: Schaltorogramme (ibertragen — LAN-Modul Einstellungen 2
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Abb. 103: Schaltorogramme (ibertragen — LAN-Modul Einstellungen 3
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LAN-Module im Netzwerk suchen
Die Suche ist nur innerhalb eines lokalen Netzwerkes méglich!

1.
2.

Aktivieren Sie das Fenster LAN Netzwerk & ua et
Klicken Sie auf [ asmakszwa 1, um bereits vorhandene LAN-Module im
Netzwerk zu suchen.

> Wenn bereits LAN-Module installiert sind, werden diese in der unteren
Tabelle angezeigt.

LAN-Modul tibernehmen:

3.
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Tragen Sie in der oberen Tabelle Seriennummer und MAC Adresse des
gew(inschten LAN-Moduls ein.

Klicken Sie in der unteren Tabelle doppelt auf das gewiinschte LAN-Modul.

> Internetzugang, HTTP Port und TCP Port werden in der oberen Tabelle
libernommen.

Geben Sie einen Namen fiir die Installation sowie einen Namen fiir die
Arbeitsgruppe ein.
Klicken Sie auf [@msma], um Ihre Einstellungen zu speichern.

Klicken Sie auf (=%, um die Seite ohne speichern der Einstellungen zu
verlassen.

4.

*me
YOUR SENSES. OUR SOLUTIONS.
Einstellungen

Namea der Arbetsgruppe [7] LAN Netowerk

Abb. 104: Schaltorogramme (ibertragen — LAN-Modul Einstellungen 4
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Abb. 105: Schaltprogramme (ibertragen — LAN-Modul Einstellungen 5



Erweiterte Einstellungen

» Klicken Sie auf [EmmwEsmas |, um den Internetzugang zu konfigurieren.
Dies ist nur notwendig, wenn der DNS Server ausgefallen ist.

m Im Feld Dynamischer DNS Server steht die IP Adresse des Grésslin-
Servers. Diese konnen Sie nicht andern.
Dynamic DNS ist ein Service, der es dem LAN-Modul erméglicht, trotz
stédndig wechselnder IP-Adressen jederzeit im Internet erreichbar zu sein.
Die IP-Adresse wird auf dem Grasslin-Server aktualisiert.

Das Feld Alternativer DDNS Server bleibt leer.
Bei einem Ausfall des ersten DNS-Servers bekommen Sie von Grésslin eine
neue IP-Adresse, welche Sie in dieses Feld eintragen.

» Klicken Sie auf [ um Ihre Einstellungen zu speichern.

» Klicken Sie auf (=@, um die Seite ohne speichern der Einstellungen zu
verlassen.

Einstellungen bearbeiten/ldschen
» Um Einstellungen zu bearbeiten, klicken Sie mit der linken Maustaste doppelt
auf das gewiinschte Feld.

» Um ein LAN-Modul zu Idschen, aktivieren Sie in der Spalte ,Léschen” die
gewiinschte Zeile mit einem Haken und bestétigen Sie mit [esa],

GRASSLIN

YOUR SENSES. DUR SOLUTIONS.

Einstellungen

Intermatzugang konfigunesen

Cynamscher DNS-Sapver 0 20 0
Aarnabiver DNS-Sarver

Abb. 106: Schaltprogramme (ibertragen — LAN-Modul Einstellungen 6
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Abb. 107: Schaltorogramme (ibertragen — LAN-Modul Einstellungen 7
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12.3 Daten senden (PC - talento LAN plus)

m Bevor Sie Daten (iber das LAN-Modul an die Zeitschaltuhr senden, miissen
Sie das LAN-Modul konfigurieren, siehe Kapitel 12.2 ,,LAN-Modul —
Einstellungen®.

1. Waéhlen Sie in der Meniileiste Datei = Senden an > talento LAN plus
> Es offnet sich das Fenster ,Upload”.
2. Wahlen Sie die gewiinschte Arbeitsgruppe und bestétigen Sie lhre Eingabe
mit [CDgoad ],
> Es offnet sich das Fenster fiir die Dateniibertragung. Der Datenupload
startet automatisch.

> Bei erfolgreicher/erfolgloser Ubertragung erfolgt eine Meldung auf dem
Monitor.
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Abb. 108: Schaltprogramme (ibertragen — Upload
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Abb. 109: Schaltorogramme (ibertragen — Upload 2




12.4 Daten auslesen (talento LAN plus = PC)

Bevor Sie Daten (iber das LAN-Modul aus der Zeitschaltuhr auslesen,
miissen Sie das LAN-Modul konfigurieren, siehe Kapitel 12.2 ,,LAN-Modul
— Einstellungen®. ops

. YOUR SENSES. OUR SOLUTIONS.
1. Wahlen Sie in der Meniileiste Datei = Offnen - talento LAN plus

> Es offnet sich das Fenster ,Download”. Download
2. Wahlen Sie im Feld Arbeitsgruppe die gewlinschte Arbeitsgruppe, in welcher 2. e | A
das LAN-Modul installiert ist. 3. Pstabation  [LANMod1 P
3. Wahlen Sie im Feld Installation das LAN-Modul (Installationsname), von 4 Datenberragungvor:_LAN-Modul 1
welchem die Programme ausgelesen werden sollen.
[Anachiuss an LAN-Modsl ..
4. Kiicken Sie auf [Bowa |, um das Auslesen zu starten. [ousnrazng on 8

> Es offnet sich das Fenster ,Dateniibertragung”.

> Bei erfolgreicher Ubertragung wird das ausgelesene Programm
angezeigt.

Abb. 110: Schaltprogramme (ibertragen — Download
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13. Schaltprogramme via Handprogrammiergerét (ibertragen

Die mit dem PC erstellten Schaltprogramme konnen Sie mit dem 13.1 Prinzip der []bertragung
Handprogrammiergerét talento taxxi plus auf die jeweilige Zeitschaltuhr

{ibertragen und umgekehrt. Die Daten werden vom PC tiber die serielle Schnittstelle COM1 oder COM2 in das

Handprogrammiergerét (ibertragen und umgekehrt.
m Sie konnen das jeweilige Schaltprogramm ausschlieBlich auf die

Schaltuhr (Typ) iibertragen, fiir die das Schaltprogramm erstelit wurde. Vom Handprogrammiergerat werden die Daten ber eine Infrarot-Schnittstelle

in die jeweilige Schaltuhr (ibertragen bzw. vom Handprogrammiergerat aus der
Schaltuhr ausgelesen.

In der gleichen Weise werden die Schaltprogramme auch von Schaltuhr zu
Schaltuhr tbertragen.

IR-Schnittstelle
-
&

D s <> @I
“Handprogrammiergert ~1

Am Ende dieses Kapitels finden Sie einige Hinweise aus der
Bedienungsanleitung des Handprogrammiergerats ,talento taxxi plus®.
Weitere Informationen siehe separate Bedienungsanleitung ,talento taxxi
plus®.
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13.2 Programmplatze auf Handprogrammiergerat formatieren

Bevor Sie Schaltprogramme via Handprogrammiergerat auf die Zeitschaltuhr
libertragen, miissen die Programmplétze des Handprogrammiergeréates auf die
entsprechende Zeitschaltuhr formatiert werden.

1. Wahlen Sie in der Meniileiste Optionen > Formatierung talento taxxi plus
- auf talento 892/992 plus oder auf talento 471/472/671 plus
> Es offnet sich das Fenster ,Formatierung®.

2. Wahlen Sie im Feld Serielle Schnittstelle die Schnittstelle Ihres PC's, an
welcher das Handprogrammiergerat angeschlossen ist.

3. Wahlen Sie im Feld Programmplatz den Speicherplatz, welchen Sie
formatieren wollen.

4. Klicken Sie auf @] um die Formatierung zu starten.
> Es o6ffnet sich das Fenster ,Dateniibertragung*“.

m Die Formatierung der Programmpléatze bleibt so lange gespeichert, bis eine
erneute Formatierung erfolgt.

GRASSLIN

YOUR SENSES. OUR SOLUTIONS.

Formatieren auf talento 892/392 plus

e — [ )

Programmplatz = -

Abb. 111: Schaltprogramme (ibertragen — taxxi
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13.3 Daten senden (PC - talento taxxi plus)

m Das Handprogrammiergerét hat vier Speichermdglichkeiten:
P 1 = 100 Programmplédtze

= 300 Programmplétze

= 300 Programmplétze

800 Programmplatze

U U U
B~ o

Anzeige auf dem Handprogrammiergerat:
— Programmplétze leer =P 1 P 2 3
— Programmplétze beschrieben = P_1, P_2, _3 _

U ©
FNOEN

1. Wahlen Sie in der Meniileiste Datei > Senden an - talento taxxi plus
> Es offnet sich das Fenster ,Schaltprogramme iibertragen®.

2. Wahlen Sie im Feld Referenzzeit Datum und Uhrzeit welche (ibertragen
werden soll.
m o Aktivieren Sie Systemzeit um das aktuelle PC-Datum auf die
Zeitschaltuhr zu iibertragen.

o Aktivieren Sie Manuell wenn Sie Datum und Uhrzeit
individuell eingeben wollen.

3. Im Feld Sommer-/Winterzeitumstellung kénnen Sie die Umschaltung von
Sommer- auf Winterzeit und umgekehrt einstellen.

o Aktivieren Sie Auto wenn die Umstellung an den vom Gesetzgeber
vorbestimmten Daten erfolgen soll (MEZ). Diese wird jedes Jahr neu
berechnet. Es ist keine Anderung méglich.

o Aktivieren Sie Manuell wenn Sie die giiltigen Daten fiir Ihren
Standort/Land manuell eingeben wollen.

e \Wenn Sie keine Umstellung wiinschen deaktivieren Sie im ndchsten

Feld ,Ubertragen® die Einstellung Sommer-/Winterzeitumstellung.
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Sie bestimmen, welche Inhalte des Schaltprogramms (ibertragen werden sollen:

— Systemzeit
— Sommer-/Winterzeit-Umschaltung
— Schaltprogramme

GRASSLIN
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Abb. 112: Schaltorogramme (ibertragen — taxxi 2



Im Feld Ubertragen kinnen Sie folgende Einstellungen vornehmen:

1. Aktivieren Sie Schaltprogramme, um die erstellten Schaltprogramme auf
das Handprogrammiergerét zu laden. Den jeweiligen Speicherplatz in den
das Schaltprogramm/Daten iibertragen werden soll, kénnen Sie im Feld
Programmplatz wahlen.

Ist der gewéhlte Speicherplatz im Handprogrammiergerat belegt, wird
dieser iiberschrieben!

2. Wahlen Sie die Serielle Schnittstelle, an welcher das
Handprogrammiergerat angeschlossen ist.

e \Wenn Sie Schaltprogramme deaktivieren, werden nur die Systemzeit
und je nach Einstellung die Sommer-/Winterzeitumstellung tibertragen.

e Deaktivieren Sie Sommer-/Winterzeitumstellung, wenn Sie keine
Umschaltung wiinschen.

3. Klicken Sie auf o] um lhre Einstellungen auf das
Handprogrammiergerét zu (ibertragen.
> Es o6ffnet sich das Fenster ,Dateniibertragung*“.
> Bei erfolgreicher/erfolgloser Ubertragung erfolgt eine Meldung auf dem
Monitor.

(bertragen
a
T —

Abb. 113: Schaltprogramme (ibertragen — taxxi 3
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Abb. 114: Schaltprogramme (ibertragen — taxxi 4
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13.4 Daten 6ffnen (talento taxxi plus = PC)

m Sie konnen die vier Programmplétze des Handprogrammiergerates

68

auslesen. s

YOUR SENSES. DUR SOLUTIONS.

. Wihlen Sie in der Meniileiste Datei = Offnen > talento taxxi plus

> Es offnet sich das Fenster ,Schaltprogramme empfangen®“.

Wahlen Sie im Feld Port lesen die Schnittstelle Ihres PC's, an welcher das
Handprogrammiergeréat angeschlossen ist.

. - . Port legsn B - Atbrechan
Wahlen Sie im Feld Programmplatz den Speicherplatz, dessen E==)
Schaltprogramm Sie auslesen mdchten. Programmele [Pt .

Klicken Sie auf ek ] um das Auslesen zu starten.

> Es offnet sich das Fenster ,Dateniibertragung“.

> Bei erfolgreicher Ubertragung wird das Schaltprogramm im Hauptfenster
angezeigt.

Abb. 115: Schaltprogramme empfangen — taxxi



13.5 Bedienungsanleitung Handprogrammiergerat

Allgemeines

m Mit dem Handprogrammiergerat talento taxxi plus senden und empfangen
Sie Schaltprogramme (Daten).

Die Schaltprogramme erstellen Sie:
e auf einem PC (Laptop) mit der Software ,talento dialog plus”

e direkt an der Schaltuhr
siehe Bedienungsanleitung der Zeitschaltuhren

Sie konnen das jeweilige Schaltprogramm ausschlieBlich in die Schaltuhr
(Typ) ibertragen, fiir die das Schaltprogramm erstellt wurde.

Das taxxi hat 4 Programmplétze.
Sie konnen 4 unterschiedliche Schaltprogramme (ibertragen bzw.
Schaltprogramme auslesen.

Anzeige auf dem Handprogrammiergerét:

— Programmpléatze leer =P 1, ,

P 2 P 3
— Programmplétze beschrieben =P_1, P_2, P_3

P 4
, P_4

~

Geratefunktionen

IR Schnittstelle
Display

Taste out
= Daten senden

Taste Prog. = Speicherplatz wahlen

PC-Schnittstelle
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Schaltprogramme in die Zeitschaltuhr {ibertragen
(talento taxxi plus = Zeitschaltuhr)

m Die Zeitschaltuhr muss sich im Taxximodus befinden,
siehe Bedienungsanleitung der jeweiligen Zeitschaltuhr.

1. Wihlen Sie mit der Prog.-Taste den entsprechenden Speicherplatz
-P_1..P_4.
Um die Uhrzeit zu (ibertragen wahlen Sie mit der Prog.-Taste ,c lo“.

2. Halten Sie die IR Schnittstelle des Handprogrammiergeréts direkt auf die
beiden IR Dioden der Zeitschaltuhr (ruhig halten).

3. Driicken Sie die Taste out 1 mal.
> Die Ubertragung wird vorbereitet, der jeweilige Programmplatz und die

Zuordnung out blinken abwechselnd.
4. Driicken Sie die Taste out nochmals.

> Die Daten werden iibertragen. Wahrend der Ubertragung erfolgt eine
akustische Meldung.

> Wurden die Daten korrekt (ibertragen steht im Display des
Handprogrammiergeréts die Nummer des Programmplatzes, z. B.P_ 1.

> Werden die Daten nicht korrekt tibertragen erfolgt eine kurze akustische

Meldung und im Display erscheint die entsprechende Fehlermeldung Er x.
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Schaltprogramme in das Handprogrammiergerat
libertragen (Zeitschaltuhr = talento taxxi plus)

Die Zeitschaltuhr muss sich im Taxximodus befinden,
siehe Bedienungsanleitung der jeweiligen Zeitschaltuhr.

1. Wihlen Sie mit der Prog.-Taste den entsprechenden Speicherplatz
-P_1..P_4.
Um die Uhrzeit zu tibertragen wahlen Sie mit der Prog.-Taste ,.c lo“.

2. Halten Sie die IR Schnittstelle des Handprogrammiergeréts direkt auf die
beiden IR Dioden der Zeitschaltuhr (ruhig halten).

3. Driicken Sie die Taste in 1 mal.
> Die Ubertragung wird vorbereitet, der jeweilige Programmplatz und die

Zuordnung in blinken abwechselnd.
4. Driicken Sie die Taste in nochmals.

> Die Daten werden iibertragen. Wahrend der Ubertragung erfolgt eine
akustische Meldung.

> Wurden die Daten korrekt (ibertragen steht im Display des
Handprogrammiergeréats die Nummer des Programmplatzes, z. B.P_ 1.

> Werden die Daten nicht korrekt tibertragen erfolgt eine kurze akustische
Meldung und im Display erscheint die entsprechende Fehlermeldung Er
X.

Fehlermeldungen Handprogrammiergerét

Beim Arbeiten mit dem taxxi kann es vorkommen, dass im Display eine
Fehlermeldung erscheint.

e Er 2 = Schaltuhr wurde nicht erkannt (Name der Applikation stimmt nicht)
o Er 1 = Daten wurden nicht korrekt iibertragen, Ubertragung wiederholen
e Er 0 = Batterien liefern nicht geniigend Spannung
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1. Introduction

Dear Customer, 1.1 Designated use
The programming software talento dialog plus can be used to create switching
programs (weekly, holiday, annual or astro programs) with the PC for digital time
switches of Grésslin.

The user software can be used to create switching programs for the following
digital time switches of Grésslin.

The program transmission device talento taxxi plus or the talento LAN plus o talento 471/472 plus
module can be used to transmit the created switching programs to the respective e talento 671 plus
time switch. o talento 892/992 plus

Preconditions for the successful work with the programming software are i
good PC knowledges and practical experiences with Windows. 1.2 Explanation of symbols

The following symbols are used in this operating manual:

Symbol | Meaning

m Information

1. Action to be carried out in several steps

| 2 Action to be carried out in one step or as an alternative
> Result of an action carried out

1.3 Scope of delivery / accessories

The following elements are included in the delivery
e Software CD
e (Qperating manual on CD
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2. Installation / deinstallation
2.1  Software / hardware requirements

Software

Hardware

e Windows 95/98/NT/2000/XP/Vista/7

e Pentium, Pentium-MMX or Pentium Il
e 512 MB RAM (1 GB recommended)
o |deal display resolution: 1280 x 1024 Pixel

External hardware:
(Digital time switches and accessories):

e Annual time switch (talento 471, 472, 671, 892, 992 plus)

o talento taxxi plus = manual programming device
o Serial cable for the connection to the PC

(Commercially available cable 1:1, included in the scope of delivery of the talento taxxi plus)

2.2. Installation under Windows

1. Insert the CD in the respective drive.

2. If the installation menu does not open automatically, click with the mouse on

the file start.exe (CD).

> The menu for the language selection opens.
3. Select the desired language and confirm your selection with [ o],

> The installation menu opens.

4. Click on and follow the installation instructions.
Once the installation is completed, the program can be started again.

2.3 Uninstalling

@talemo dialog plus

During installation, the link "Uninstall" has been created in the target

program group. Do not delete the software manually!

Welcome to the talento dialog plus
Setup Wizard

il quide you through th 2 darko

This .
dislog phus.
It is recommended that you close all ather

Ibefore starting Setup. This will make i possible to update
relewant system files without having to reboot your
computer.

Click Nexet: to continue.

Fig. 1: Installation menu

75




3.  Starting the program GRASSLIN
1. Start the program by double clicking on the symbol of the respective program YOUR SENSES, OUR SOLUTIONS.

group. (names have been specified by the customer)
> The start screen of the program is displayed.
What would you like to do?

2. Select the desired language in the box Select a Language. R
» Click on to create an individual switching program. 2. — g . 3 (e T | T
» Click on to open an already stored switching program. > Losdhimipsd
» Click on to transmit a switching program from the manual
programming device talento taxxi plus to the PC.
» Click on to transmit a switching program from the time
switch to the PC via a LAN module.
» Clickon to quit the program. et
Fig. 2: New switching program - Start screen
3.1 Creating a new switching program
3. Click on to create an individual switching program. =
> The page "Select a Timer" is displayed. ﬁg&&éﬂ&!m
4. Click on the box Timer Model to select the type of time switch for which the
switching program is to be created.
> The box Channels shows automatically the number of channels of the Select a Timer
time switch. Times Model
5. According to the type of time switch, you can set the number of channel 4. oo 2 * o J[Ceama ]
extensions in the box Extensions.
6. Click on ek to confirm your inputs. 5. o )

> The page "Select Location" is displayed (only with talento 892/992 plus).

Fig. 3: New switching program - Selection of time switch
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7. Select your location in the box Select Location
(only with talento 892/992 plus).

8. Click on[@_] to confirm your inputs.
> The main menu is displayed.

3.2 Opening a file

3. Click on [ toadkomrie | to open an already stored switching program.

> This will open the window "Open".
4. Select the folder in which the file is stored.

5. Open the file with a double click or select the file and click on [Ofien_].
> The program is loaded and displayed in the main menu.

YOUR SENSES. OUR SOLUTIONS.

talerto 892992 plus

Fig. 4: New switching program - Selecting the location

Offnen

I

Fig. 5: New switching program - Opening a file
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3.3

taxxi transmission
Click on [ Lesdiomimss | to load a switching program from a manual
programming device.

Select the box Read from Port to choose the serial interface to which the
manual programming device is connected.

In the box Program place, select the desired storage location to be loaded.

6. Confirm your input with [ ek

78

> The program is loaded and opened on the main menu.

YOUR SENSES. OUR SOLUTIONS.

4 ——
5 ——

Resdtrom Port B ]

I |

Frogramplace [Pl -

Fig. 6: New switching program - taxxi transmission



3.4  LAN transmission

3. Click on to transmit a switching program from the time
switch to the PC via a LAN module.

> The window "Configuration" opens.

m Before reading out data from the time switch, you have to configure the
LAN module in the software "talento dialog plus"!

Click on to display, edit or recreate the respective work group.
Further information can be found on page 124, chapter 12 "Transmission of
switching programs via LAN module”.

4. If LAN modules are already configured, click on 8k,
> The window "Download" opens.

5. In the box Workgroup, choose the desired work group in which the LAN
module is installed.

6. Inthe box Installation, select the LAN module (installation name) from which
the programs are to be read out.

7. Click on to start the reading out process.
> The window "Transmission" opens.
> If the transmission was successful, the read out program is displayed.

No o

RASSLIN

YOUR SENSES. OUR SOLUTIONS.

Configuration

Wodoow! 3 | (Cagoroion]
Wiotkgroup? [Configwaion |
Workgroup3 [Configuration |
Worgroupd [Corfiguration |
Workgroups Configuration
- (Cortgraion]
o (Corbqrason)
ez (Corbqrain]
Wodgass (Cargrsion)
(= . [Contowssen)

Fig. 7: New switching program - LAN transmission

RASSLIN

YOUR SENSES. OUR SOLUTIONS.

Download

roup (LA ol |

Instaflation |LAN modgle 1 -

Lowding daa from: LAN modube 1

Fig. 8: New switching program - LAN 2 transmission

(oneioad ] (" Comcal_]
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4. User interface

41 Overview

Menu bar
Toolbar

Register
Graphic

representation
(graphic)

Tabular
representation
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Fig. 9: User interface - Overview



4.2 Menu bar 4.4 Register
Menu Menu items Register Function
File New; Load (File / talento taxxi plus / talento LAN plus); Send To Weekly program Settings of the weekly program
(talento taxxi plus / talento LAN plus); Save; Save As; Print; Exit Annual program Settings of the annual program
Edit New program (ON/OFF, Pulse, Cycle) Astro program Settings of the astro program
Options Set Device/Channels; Select Location; Customize icons; Change CH1. .. CH8 Selection of the channel (channel 1, ..., channel 8)
Language; Set priority; Configuration (talento LAN plus); S -
Format talento taxxi plus (for talento 892/992 plus / for talento
471/472/671 plus)
Help Info; Help
4.3  Toolbar
Symbol Command

Save the project

=

Print the project
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4.5  Graphic representation (graphic)

The graphic representation gives a quick overview of the start and end times of
the different switching programs.

451 Weekly program

The days of the week are indicated on the vertical axis, the time is shown on the
horizontal axis.

4.5.2 Holiday program (talento 471, 472, 671 plus)

The days of the week are indicated on the vertical axis, the time is shown on the
horizontal axis.

» Activate Set to Holiday to create a holiday program.
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Fig. 10: Graphic representation - weekly program
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Fig. 11: Graphic representation - holiday program



4.5.3 Annual program

The channels are indicated on the vertical axis, the time is shown on the
horizontal axis. The selected channel is shown with a white background.

» In the register, select All Channels to display all channels.
It is not possible to edit the switching program on this level.

45.3 Astro program

For the astronomic programming, no graphic representation of the switching
programs is available.

455 Setting the scaling factor

The grid for the graphic representation can be set via the selection box Time
Increment.

Time increment |1 hour |
) 1200 20:00 21:00 | 22:00 [23:00

Fig. 13: Setting the scaling factor

The following grid settings are possible:
5 minutes, 15 minutes, 30 minutes, 1 hour

~

Aol Pyt aumm Prograens

0

7 [€H3 [GM4 | AE [CHB | AT | CHA | M Chimeet

0000 0100 (00 N0 G405 0500 0600 0700 (MO0 NGO 1000 1100 KI00 N300 400 1400 1600 1700 W00 MRO0 000 IO F00 IM00

. 12: Graphic representation - Annual program
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4.6 Tabular representation

For all weekly, holiday, annual and astro programs, all the information of a
switching program is shown in the table. Each switching command (e.g. ON or
OFF) are shown in one table column.

m If you click the left mouse button on a switching command in the table, this
command is highlighted.
If you click the right mouse button, a menu opens. Select Delete to delete
the switching program.

4.6.1 Weekly program

[}
o
m
bl

A Program number of the switching commands

B Type of switching command (ON, OFF, pulse, cycle ON or cycle OFF)

C Start or end time of the switching command
Using the pull down menu [ hours (dd) and minutes (mm) can be set.

nojgeaos
o E.E.DIHIE!i

D Pulse Duration
The pulse duration shows the ON switching duration of a switching
command in case of a pulse or cycle program. Fig. 14: Tabular representation - weekly program
The pull down menu ¥ can be used to set days (dd), hours (hh), minutes
(mm) and seconds (ss).

E Cycle Period
The period shows the duration of a cycle.
The pull down menu ¥ can be used to set days (dd), hours (hh), minutes
(mm) and seconds (ss).

F Days of week
You can select the day of the week on which the respective switching
program is to be started or finished. Tick the box "Daily" if the switching
command is to be carried out every day.
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4.6.2 Holiday program

A Program number of the switching commands

B Type of switching command (ON, OFF, pulse, cycle ON or
cycle OFF)

C Start or end time of the switching command Fig. 15: Tabu/a'r'representation - holiday program
Using the pull down menu [* hours (hh) and minutes (mm)
can be set.

D Pulse Duration
The pulse duration shows the ON switching duration of a
switching command in case of a pulse or cycle program.
The pull down menu ¥ can be used to set days (dd), hours
(hh), minutes (mm) and seconds (ss).

E Cycle Period
The period shows the duration of a cycle.
The pull down menu [* can be used to set days (dd), hours
(hh), minutes (mm) and seconds (ss).

F Days of week
You can select the day of the week on which the respective
switching program is to be started or finished. Tick the box
"Daily" if the switching command should be carried out
every day.

G Start date of the holidays
The pull down menu ¥ can be used to set the day and the
month.

H End date of the holidays
The pull down menu [* can be used to set the day and the
month.
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4.6.3 Annual program

A Program number of the switching commands
B Type of switching command (ON, OFF, pulse, cycle ON or cycle OFF)

C Start time of the switching command

Using the pull down menu [ hours (hh) and minutes (mm) can be set.

D End time of the switching command

Using the pull down menu [ hours (hh) and minutes (mm) can be set.

E Pulse Duration

The pulse duration shows the ON switching time of a switching command

in case of a pulse or cycle program.

The pull down menu ® can be used to set days (dd), hours (hh), minutes

(mm) and seconds (ss).

F Cycle Period
The period shows the duration of a cycle.

The pull down menu ¥ can be used to set days (dd), hours (hh), minutes

(mm) and seconds (sS).

G Only this year

You can select whether the switching command should be applicable only

for the selected year or should be carried out every year.
Activate Only this year if the switching command should only be
applicable for the selected year.
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4.6.4 Astro program

A Program number of the switching commands

B Date range
The date range shows the start and the end date of an astro
program.

c Offset
The offset range shows the offset of the ON/OFF switching times
at sunrise and sunset.

D Night off period
The nighttime switch-off shows the ON/OFF switching times
which are within the period between sunset and sunrise,
e.g.23-5h.

E Program
The status of the switch shows the selected type of switching
command at sunrise and sunset.

A B C D
Date rarge Offset. aght off penioa
frem To Sunie Surnet o on Sunset
ones e 401,00 -00:1% 0000 0200 on
Fig. 17: Tabular representation - astro program
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5.  Menu bar
5.1 The menu FILE

New

» Select File > New, to create a new switching program.
> If a switching program which is not yet stored is open, the following
question appears automatically: "Would you save the program?”.
Select Yes/No to save/delete the switching program.

Load

> Select File > Load - File, to open an already existing program.

> Select File > Load - talento taxxi plus, to transmit a switching program
from the manual programming device talento taxxi plus to the PC and to
open it.

» Select File > Load - talento LAN plus, to transmit a switching program
from the time switch to the PC via a LAN module.

Send to

» Select File > Send to > talento taxxi plus, to transmit a switching
program from a PC to the manual programming device talento taxxi plus.

> Select File > Send to > talento LAN plus, to transmit a switching
program to the time switch via LAN module.

m You will find more detailed information on the transmission of switching
programs in the chapter 12 "Transmission of switching programs via LAN
module" and chapter 13 "Transmission of switching programs via manual
programming device".

Save
» Select in the menu bar File = Save, to save the switching program.
Choose an appropriate name for your file, allowing you to find it again later.

The file extension must always be .swp!
88
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Fig. 18: FILE menu

Save as

» Select File > Save as, to save the switching program under a different
name.

Choose an appropriate name for your file, allowing you to find it again later.
The file extension must always be .swp!

Print
» Select File = Print, to print the switching program.

Exit

» To quit the programming software, select File > Exit,.
> If a switching program which is not yet stored is open, the following
question appears automatically: "Would you save the program?"
Select Yes/No to save/delete the switching program.



5.2  The menu EDIT

New program

» Select Edit > New Program, to create a new ON/OFF, pulse or cycle
switching command.

Weekly Programs | Annual Programs | 4

e

Cycle

Fig. 19: EDIT menu
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5.3  The menu OPTIONS

Set Device/Channels

» Select Options > Set Device/Channels, to select a new time switch or to
add channel extensions.
> If a switching program which is not yet stored is open, the following
question appears automatically: "Would you save the program?"
Select Yes/No to save/delete the switching program.

Select location

> Select Options > Select Location, to set your location. This is done in order
to determine the public holidays for the annual programming.

Customize icons

» Select Options = Customize icons, to assign a symbol to the individual
channels.

Change language

» Select Options = Change Language, to change the language of the
programming software.

Set priority

> Select Options > Set priority, to assign a priority to the different program
types.
See chapter 7.4 "Setting the priority of switching programs".
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Fig. 20: OPTION menu

Configuration

» Select Options > Configuration - talento LAN plus to make settings for
the LAN module (talento LAN plus).
See chapter 12.2 "LAN module - settings"

Format talento taxxi plus

> Select Options > Format talento taxxi plus > for talento 892/992
plus or for talento 471/472/671 plus, to format the program places of the
manual programming device for the respective time switch.
See chapter 13.2 ,,Formate program places on manual programming device*.



5.4  The menu HELP

Info

» Select Help - Info to get further information on the software (software
version, imprint).

Help

» Select Help > Help, to open the software manual.

@ talento dialog plus

i Eile Edit Options | Help

=12 info

Weekly Programs | Annual P Help F1 |

CH1 [CH2 [CH3 [CH4 |CH5 [CHB |CH7 |CHB |
| Dn@_'tfjﬁl Pulse | [Ar Cycle |

Fig. 21: HELP menu
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6.  Switching commands

In the weekly and annual program, three different switching commands can be selected:

ON/OFF * ON switches the channel on.
e QFF switches the channel off.
m The status of the consumer is maintained until the next ON or OFF switching command is carried out.
Pulse * Switches the channel ON for a short time |
s ) Start
A pulse switching command consists of: time |
— Start time — | Pulse o
— Pulse duration = ON switching duration duration
15.00h
Cyc|e . Swi_tches the channel ON or OFF for a defined time ! Period !
period. Start ; |
e A cycle switching command consists of: time —-—
— Start time Cbuse ke |
— Pulse duration = ON switching duration duration N | ‘
ause |
— Period = ON switching duration + pause L |
— Cycle duration = Period between channel T ewh . ooon
ON and channel OFF L Duration of the cycle R
I~ 1
— Stop time Channel ON Channel OFF

The cycle duration must not be less than the period.
No nesting of cycle programs is allowed.
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Graphic representation of the switching commands

e |f two switching commands are active at the same time, the two symbols

Switching command Symbol are combined in one symbol, for example )

ON o |f three or more switching commands are active at the same time, the
following symbol K is displayed.

OFF Click the right mouse button on the symbol &3 to show all switching
commands.

Pulse I

Cycle Ir ONOFF 1., > | @] oelete ctvore 1

PULSE 2... » i t
2 switching commands at the same V i ¥
time o Create new program. .. »
i

3 or more switching commands at the

. Fig. 22: Switching commands
same time
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7.  Switching programs
7.1 Creation of switching programs

The switching commands are represented by the buttons (O] and The switching commands can also be created as follows:
(A7 Cycie]| 1. Click with the right mouse button on any place in the graphic.

1. Click on the respective symbol to select a switching command.

> As soon as you place the mouse pointer on the graphic, it will change
into the selected symbol.

2.

2. Click with the left mouse button in a field to place the ON switching
command.
In the case of an ON/OFF and a cycle switching command, click a second
time in another field to place the OFF switching command.
> Depending on the type of switching command, a second settings window
opens

m If you click outside the graphic, no switching command is placed and
you have to select the desired symbol for the switching command
again.

3. To change the start and end time of a switching command, place the mouse
pointer in the table under the graphic representation on # and click the left
mouse button. 1.
> A pull down menu opens. You can set the time to the minute

or

m A switching program consists of several switching commands!
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> A selection field opens.

Click on Create new program and choose the desired switching command.
0900 1000 11:00 1200 1300 1400 15:00 |

[0si00 | 07:00 b0 08
! | HoEvens) | I
| [D cesenewprogram...  » =
1] -
| I | | =

Fig. 23 Creating a new switching program

T

Click with the left mouse button in the desired field in the graphic to place
the switching command.

Click in the menu bar on Edit > New Program and select the desired
switching command.

i Eile || ions  Help

i & NewProgram  » o OO
‘Weekly Programs Annusl Programs _ Bulss
[CH1 [on2 ona [ona [ons (1 Qvck

Fig. 24: Creation of a new switching program 2

Click with the left mouse button in the desired field in the graphic to place
the switching command.



7.2  Deleting switching programs

To delete a switching program, click with the right mouse button on the desired
switching program in the table and delete it.

Fig. 25: Deleting a switching program

or

Click the right mouse button on the desired switching program in the graphic
representation and delete it.

0 05:00 06:00 |07:00 08:00 09:00 | 10:00 11:00 1200 13:00 141

L= ! ! ! ;
[ ONOFFl. v ) Delete ONOFF 1 '

Fig. 26: Deleting a switching program 2

~

7.3  Copying a switching program

You can copy a new switching program on several channels. The number of

channels depends on your time switch and its channel extensions.

1. Click on the desired symbol [CONBI] [ Puise] or [ Gyvle] for the switching
command.

2. Inthe field Copy new event to, activate the channels on which the new
switching programs should be copied.

Copy new event to
CH1 [EHCH2 EJCHA [JCH4 I CHS I CHE [JCH7 [JCHB

Fig. 27: Copying a switching program
> The selected channels are ticked.

3. Create your switching program.
> The created switching program is copied on all selected channels.

m If you want to copy a switching program afterwards to another channel,

double click on the desired program in the table and activate the channels
on which the switching programs are to be copied.
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7.4  Setting the priority of switching program types
Weekly, annual and astro programs should not be active at the same time. Select
a different priority for each type of switching program.

There are 10 different priority levels which can be freely selected.
00 = highest priority
09 = lowest priority

The priorities are factory set.

Type of switching program Priority level

- 00 (highest priority)
Singleday/Annual* 03

Annual program 05

Astro program 05

Weekly program 07

- 09 (lowest priority)

*"Singleday/annual programs" are annual programs which are only applicable to
one single day (start and end date are identical).

1. Select Options > Set priority to set the priority of the switching program
types.
> The window "Priority Table" opens.

2. In the pull down menu, select ™ the desired priority for the individual
switching program types.

3. Click on 22 to confirm the settings.
> If the switching programs coincide in time, the type of switching program

with the highest priority is automatically selected and started.
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8.  Weekly program
8.1  General information

e A switching program consists of several switching commands! 8 £ oo IN
 The grid for the graphic representation can be set via the selection field Time el e e =
Increment. BT T s R
BE0D 0190 OT08 w‘w..ﬂ.ﬁ. wa“m m_n_-“u_mn__rx- B0 M0 1300 1600 lr.u 1? W00 |0 TINO 7300 F00
Time increment 1 how = w [ - CH| ! | ! !
B we = (] ]
) . ™ | = | |- L]
e If you click on [ in the table, a pull down menu opens. n e o 1% 3 "
You can set here the time, the pulse duration and the cycle period to the » = ™ = =
minute and to the second. - e Dap e
5 : 1 B T} T
o ECE selae|e[s | B8] 8
o e ge oojojo/oilo| D
cer R CE LA NS =R =E =R E =N N-]
o {12 & w0 8] g0 0ejoio/ojol O
oFF rcy == e R e =]
o WEws g0 0DoojojAaio|n
| v XL 1B | | o Soooopo]elon
[ 7| Puse o e Sloidieese de 8f W el el TS S B B R B BB B
L3 mm u»n-m»n-m»_u-m-__u-mvm'nnnmmI7.:=| o
EVELE OFF (LN T TS . . R O N R N - = ]
Fig. 29: Pull down menu
e To delete a switching program, click the right mouse button on the desired 2 L
program in the table and delete it. e e
Fig. 30: Weekly program
[~
on 0 I B )
Fig. 31: Deleting a switching program
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8.2  Weekly program — ON/OFF

Example

A courtyard lighting is to be automatically switched ON and OFF:

Monday to Friday
05:30 h ON 08:30 h OFF
17:00 h ON 21:30 h OFF

Saturday
05:30 h ON 08:30 h OFF

On Sundays, the courtyard lighting remains OFF.

Starting the program

1. Start the program and select your time switch.
(see chapter 3)

> The main menu is displayed.
2. In the register, click on the button Weekly Programs.

3. Select in the register the channel for which the weekly program should be
created, e.g. CH1 = channell

ON / OFF programming

4. Select the switching command (&g,

5. Click with the left mouse button in the line for Monday on the field 05:30 to
set the first ON switching command and then in the field 08:30 to set the first
OFF switching command.

Afterwards click in the field 17:00 to set the second ON switching command
and then in the field 21:30 to set the second OFF switching command.

> The entered switching program is now shown in form of a graphic and in
form of a table.
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Fig. 32: Weekly program - ON/OFF
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Fig. 33: Weekly program - ON/OFF
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6. Activate in the table also the weekdays Tuesday to Saturday and set
the first ON and OFF switching command and the weekdays Tuesday
to Friday to set the second ON and OFF switching command.

Fig. 34: Weekly program - table ON/OFF
> The modifications are now shown in the graphic representation.

7. Select File > Save in the menu bar to save the switching program.

m Choose an appropriate name for your file, allowing you to find it again
later. The file extension must always be .swp!

@& ree——— ot
W PIEUTE deewn Freguma s P |
CINCT
(oo (8 e |8 Gon | T et Tmese
mmmwunwnmﬂmuammu unmlmwalwun:mmumumnam
. (m g- 1
b T T = > E.
e | — ~—im
n (] > ]
" ] (]
o (] j
=

A\

Dy of week:
0 Tu We Th Fr 53 Se D
B B B B 8 B B Be = 2 5 8 5 2 &
1 oFF X | & WEielElE e 00
= | o oo M el RPN R e A s W e 8B 8 @000
OFF nEms *» % ¥ » « w « 2A'AABABS OO0

Fig. 35: Weekly program - ON/OFF 3
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8.3  Weekly program - Pulse

Example

Channel 1 should be switched ON from Monday to Friday at 15:00 h.
The ON switching duration is 15 minutes.

Starting the program

1. Start the program and select your time switch.
(see chapter 3)

> The main menu is displayed.
In the register, click on the button Weekly Programs.

3. Select in the register the channel for which the weekly program should be
created, e.g. CH1 = channell.

Pulse programming
4. Select the switching command & e,

5. Click with the left mouse button in the line for Monday on the field 15:00 h to
set the ON switching command.

> The settings window for the pulse duration opens.
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Fig. 36: Weekly program - Pulse
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Fig. 37: Weekly program - Pulse 2



6. Set the minutes and seconds for the pulse duration and confirm your input by H
clicking on OK. I=EY Ll

e e
e un |
(0] P G| el el e

0000 0100 (00 (N0 D400 CN0D 9690 0700 ONS0 ORO0 IGO0 1190 1ID0 MI00 00 MO0 1E00 1TE0 1R00 1RD0 2080 2100 1200 2300

TR

Fig. 38: Weekly program - Setting pulse duration Fig. 39: Weekly program - Pulse 3
7. Activate in the table also the weekdays Tuesday to Friday.
fy T GRASSLIN
Woraly Progrens et Pragrams Aates Porpis
CH1 eH}
[ | wune |y B e
. 0000 0LO0 GO S309 40O SS00 DEOD 0700 DRG0 (R0 1060 1KOO 1300 1N08 uni&m 1700 WR00 1R00 3000 FEO0 3200 7300
Fig. 40: Weekly program - Table Pulse * B
> The modifications are now shown in the graphic representation. = W
" =
8. Select in the menu bar File = Save to save the switching program. =
Choose an appropriate name for your file, allowing you to find it again - = e o —
later. The file extension must always be .swp!

Fig. 41: Weekly program - Pulse 4
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8.4  Weekly program - Cycle

Example

Channel 1 is switched ON every hour for 10 minutes, starting on Monday 9.00
am. The stop time is Friday 19.00 pm.

Start time Monday 9.00 h
Duration 10 min.
Period 1h
Stop time Friday 19.00 h
Starting the program

1. Start the program and select your time switch.
(see chapter 3)

> The main menu is opened.
In the register, click on the button Weekly Programs.

3. Select in the register the channel for which the weekly program should be
created, e.g. CH1 = channell.

Cycle programming
4. Select the switching command &z,

5. Click the left mouse button in the line for Monday on the field 09:00 h to set
the ON switching command and then in the line for Friday on the field 19:00
h to set the OFF switching command.
> The settings window for the pulse duration and the period of the cycle
opens.

m The pulse duration must not be less than the period.
No nesting of cycle programs is allowed.
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Fig. 43: Weekly program - Cycle
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6. Set the days, hours, minutes or seconds for the pulse duration.

Pulse duration
oo v oo Wil Wi ¥
dd hin mm 55

Fig. 45: Weekly program - Pulse duration

7. Set the days, hours, minutes or seconds for the period and confirm your input
by clicking on OK.

o o]

Fig. 47: Weekly program - period

> The switching program is shown graphically and tabularly.
8. Selectin the menu bar File > Save to save the switching program.

Choose an appropriate name for your file, allowing you to find it again
later. The file extension must always be .swp!
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Fig. 46: Weekly program - Cycle 3

103




9. Holiday program

The holiday program is a weekly program to which a date can be assigned. This
function is only available in the time switches talento 471, 472 plus and talento

671 plus.

Example

A courtyard lighting is to be switched ON and OFF automatically during the
summer holidays from August 2 to August 21.

Monday to Friday
06:00 h ON 08:00 h OFF
20:00 h ON 21:00 h OFF

On Saturdays and Sundays, the courtyard lighting remains OFF.

Starting the program

1. Start the program and select your time switch.
(see chapter 3)
> The main menu is displayed.

2. Select in the register the channel for which the holiday program should be
created, e.g. CH1 = channel1

3. Activate Set to Holiday.

ON / OFF programming
4. Select the switching command [asge],

5. Click the left mouse button in the line for Monday on the field 06:00 to set
the first ON switching command and then in the field 08:00 to set the first
OFF switching command.
> The settings window "Holiday Settings" opens.
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Fig. 48: Holiday program - ON/OFF
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m For a cycle and pulse switching command, you also have to set the pulse
duration and/or the period.

6. Set the start date (day (DD) and month (MM)) of the holidays.

Holiday Settings =
Holiday Date Begin
2 B[ & @
as] M

Fig. 50: Holiday program - start of the holidays
7. Set the end date (day (DD) and month (MM)) of the holidays.

Holiday Date End

27 g 8 @
oD MM
(o ]

Fig. 51: Holiday program - end of the holidays

8. Confirm your input with 8],
> The switching program is shown graphically and tabularly.

9. Afterwards click in the field 20:00 to set the second ON switching command
and then in the field 21:00 to set the second OFF switching command.
> The settings window "Holiday Settings" opens.
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Copy sew Event B0
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Fig. 52: Holiday program - ON/OFF 3
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10. Set the start and end date of the holidays.
> The entered switching program is now shown in form of a graphic and in
form of a table.

11. Activate the weekdays Monday to Friday in the table to set the ON and OFF
switching commands.

OFF (21 w00 v v é; \-
Fig. 53: Holiday program - Table ON/OFF
> The modifications are now shown in the graphic representation.
12. Select in the menu bar File > Save to save the switching program.

m Choose an appropriate name for your file, allowing you to find it again
later. The file extension must always be .swp!

» To delete the switching program, click the right mouse button on the desired
program in the table and delete it.

on (T EoE = = =

Fig. 55: Deleting the switching program
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10. Annual program
10.1 General information

e A switching program consists of several switching commands!
e The grid for the graphic representation can be set via the selection field Time
Increment.
Time increment 1 hou &
e If you click on [ in the table, a pull down menu opens.

You can set here the start and end time, the pulse duration and the period to
the minute and to the second.

Fig. 55: Pull down menu

¢ To edit the date for the ON/OFF, pulse or cycle switching command, click the
left mouse button two times on the selected switching program in the table
and choose a new date.
Afterwards click on &% to save your settings.

To delete a switching program, click the right mouse button on the desired
program in the table and delete it.

|3 PUSE 08 v 00 09 ¥ 05 ¥ 00 v 00 ¥ 05 ¥ 00 ¥

Fig. 57: Deleting the switching program
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Fig. 56: Annual program

107




10.2 Annual program — ON/OFF

Example 1

A shop window lighting is to be switched automatically ON and OFF from April
1 to September 30:

Daily

06:00 h ON 22:00 h OFF

Starting the program
1. Start the program and select your time switch.
(see chapter 3)
> The main menu is displayed.
2. Inthe register, click on the button Annual Programs.

3. Select in the register the channel for which the annual program should be
created, e.g. CH1 = channeld.

ON / OFF programming
4. Select the switching command [Eg],

5. Click the left mouse button in the line for the channel 1 (CH1) on the field
06:00 to set the ON switching command and then in the field 22:00 to set
the OFF switching command.

6. Click the left mouse button on April 1 in the calendar, keep the shift key
pressed and click then on September 30.
or
Click the left mouse button on April 1 in the calendar and keep the mouse

button pressed. Move the mouse pointer to September 30 and release the
mouse button.

> The selected days are shown bold letters and are highlighted in white
color.
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Fig. 58: Annual program - ON/OFF
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7. Click on 2=y to save the settings.

Apply
> This will open the window “Selection of program*.
. . Cancel Holidays
8. Select whether the switching command should be applicable only for the OrCIIckon'meDesl Fed Dotes
f:le;catgd year (Annual non repeat) or should be repeated every year (Annual ! Group |StartTime§nuTlm_e - [ Puiss diration. i
peal). I hh mm hh mm | dd  hh  mm  ss | d

# | Type
1 ON OFF |06 n oo u 22 n 00 n

Fig. 60: Annual program - Table ON/OFF

Please select the type of program required,

| Anouairepeat | | Aanual non repeat |

Abb. 61 Annual program - Selection of program
> The switching program is shown graphically and tabularly.

» To edit the date for the ON/OFF switching command, click the left mouse
button two times on the selected switching program in the table and choose
anew date.

Afterwards click on &% to save your settings.
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4,
5.

110

itching program for public holidays

Select the switching command ],

Click with the left mouse button in the line for the channel on the desired
field to set the ON switching command and then in the field for the OFF
switching command.
Click on [masms_] to select the holidays.
> The settings window "Holidays" opens.
Click on Country/Region and select the respective country.

CountryiRegon

|Unaed Kingsom |

Fig. 62: Annual program - Country selection

> In the field Public Holidays the public holidays of the respective country
are listed.

Click the left mouse button in the first table column to select the desired

public holiday.
Public Holidays
Name Diate (dd menuyy) - @
New Toars Day om0
| Goad Friday 02042010
040420
| Enster Wonday 105042010
May Dy Biank Holday S0 |
Spring Bark Holiday 30520 -

[Ca ] [Ctone | [CPoomg | [ roea |
Fig. 64: Annual program - Selection of public holidays

Click on = to select all public holidays.
Click on =] to deselect all public holidays.
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Abb. 63 Annual program - Holidays



» Click on [P to select all public holidays with a flexible date such as
Easter.

» Click on [#=] to select all public holidays with a fixed date such as
Christmas.

9. Confirm your input with OK.

> In the calendar, the public holidays are shown in bold letters.
10. Click on to save the settings.

> This will open the window “Selection of program*.
1

_

. Select whether the switching command should be applicable only for the
selected year (Annual non repeat) or should be repeated every year (Annual
repeat).

Please select the type of program required,

| Anouairepeat | | Aanual non repeat |

Abb. 65: Annual program - Selection of program
> The switching program is shown graphically and tabularly.

m If flexible days are chosen, the window ,,Calculation of flexible holidays*
opens.

Caleulation of Rewble holidays

Please select the year up to which flexdble holidays should be
automatically calculated,

we s [ o [ _cwmm ]

Abb. 66: Annual program - Calculation of flexible holidays

Please select the year up to which flexible holidays should be automatically
calculated and confirm your input with OK.

Switching program from one year to the next

A shop window lighting is to be switched automatically ON and OFF from April
1, 2010 to March 30, 2011:

Daily

06:00 h ON 22:00 h OFF

4. Select the switching command [E&,

5. Click the left mouse button in the line for the channel on the field 6:00 h to
set the ON switching command and then in the field 22:00 h to set the OFF
switching command.

6. Click the left mouse button on April 1, 2010 in the calendar, keep the shift
key pressed and click then on December 31, 2010.

7. Select the year 2011 fver [ @ =

8. Click with the left mouse button on January 1, 2011 in the calendar, keep the
shift key pressed and click then on March 30, 2011.

9. Click on to save the settings.

10. Select whether the switching command should be applicable only for the
selected year (Annual non repeat) or should be repeated every year (Annual
repeat).
> The switching program is shown graphically and tabularly.
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10.3 Annual program - Pulse

Example

Channel 1 should be switched ON every day from July 1 to October 30 at
15:00 h.

The ON switching duration is 15 minutes.

Starting the program

1. Start the program and select your time switch.
(see chapter 3)

> The main menu is displayed.
In the register, click on the button Annual Programms.

3. Select in the register the channel for which the annual program should be
created, e.g. CH1 = channeld.

Pulse programming

4. Select the switching command & e,

5. Click the left mouse button in the line for channel 1 (CH1) on the field 15:00
h to set the ON switching command.

> The settings window for the pulse duration opens.

6. Set the minutes and seconds for the pulse duration and confirm your input by
clicking on OK.

Fig. 68: Annual program - Pulse duration
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7. Click the left mouse button on July 1 in the calendar, keep the shift key
pressed and click then on October 30.

or
Click the left mouse button on July 1 in the calendar and keep the mouse

button pressed. Move the mouse pointer to October 30 and release the mouse
button.

> The selected days are shown bold letters and are highlighted in white color.

8. Click on to save your settings.
> This will open the window “Selection of program*.

O Cani on the Deseed Date:
St Tme 03 Tme Fuing durston
W oW e

T o omm o oem

9. Select whether the switching command should be applicable only for the
selected year (Annual non repeat) or should be repeated every year (Annual
repeat). 7.

Please select the type of program required.

| Anouairepeat | | Aanual non repeat |
- Group | Start Time = End Time Pulse duration
Abb. 70: Annual program - Selection of program I | e hh | mm | hh mm  dd | hh ‘mm | ss | d
> The switching program is shown graphically and tabularly. puse |15 (oo [ s @ 15 ' o0 ' oo s Bl

> To edit the date for the ON/OFF switching command, click the left mouse Fig. 71: Annual program - Table pulse

button two times on the selected switching program in the table and choose a
new date.
Afterwards click on C—#s% 1] to save your settings.
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Switching program for public holidays

4. Select the switching command & e,
5. Click the left mouse button in the line for the channel on the desired field to

set the ON switching command. GRKSSLIN

> The settings window for the pulse duration opens. YOUR SENSES. OUR SOLUTIONS.
6. Set the minutes or seconds for the pulse duration and confirm your input by R
clicking on OK. [Unied Kinglom
7. Click on [haa=s ] to select the holidays. Putic Holidays
> The settings window "Holidays" opens. Name Dt (dd enyy)
Meow Year's Day 01.01.20010
8. Click on Country/Region and select the respective country. Good Fday R
CountyRegion ﬁimwmv oo
e trgten ol e 1 0e010

A ) [Chome | [Crowng | [ ;o |

Fig. 72: Annual program - Country selection Abb. 73: Annual program - Holidays
> In the field Public Holidays the public holidays of the respective country
are listed.
9. Click with the left mouse button in the first table column to select the desired
holiday.
Public Holidays
MName Drate (dd mm yy) - &
New Yoar's Day [0.0namo
| Goad Friday 02042010
040420
| Enster Wonday 105042010
May Ouy Banik Holiday S0 |
Spring Bark Holiday 30520 -

[ ) [Cwone | [roang | [ roma |
Fig. 74: Annual program - Selection of public holidays
» Click on =1 to select all public holidays.
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» Click on == to deselect all public holidays.

» Click on [C¥==w] to select all public holidays with a flexible date such as
Easter.

» Click on [#= ] to select all public holidays with a fixed date such as
Christmas.

10. Confirm your input with OK.
> The public holidays are shown in bold letters in the calendar.

11. Click on &% ] to save the settings.
> This will open the window “Selection of program*.

12. Select whether the switching command should be applicable only for the
selected year (Annual non repeat) or should be repeated every year (Annual
repeat).

Please select the type of program required,

[__Anowairepeat | [ anouainon repeat |

Abb. 75: Annual program - Selection of program
> The switching program is shown graphically and tabularly.

E If flexible days are chosen, the window ,,Calculation of flexible holidays*
opens.

Caleulation of Rewble holidays

Please select the year up to which flexdble holidays should be
automatically calculated,

T [ o J[ cocer |

Abb. 76: Annual program - Calculation of flexible holidays

Please select the year up to which flexible holidays should be automatically
calculated and confirm your input with OK.

Switching program from one year to the next

Channel 1 is to be switched ON every day from April 1, 2010 to March 30,
2011 at 15:00 h.
The ON switching duration is 15 minutes.

4. Select the switching command & e,

5. Click the left mouse button in the line for channel 1 (CH1) on the field 15:00
h to set the ON switching command.
> The settings window for the pulse duration opens.

6. Set the hours, minutes or seconds for the pulse duration and confirm your
input by clicking on OK.

7. Click with the left mouse button on April, 1, 2010 in the calendar, keep the
shift key pressed and click then on December 31, 2010.

8. Select the year 2011 vex % =

9. Click the left mouse button on January 1, 2011 in the calendar, keep the shift
key pressed and click then on March 30, 2011.

10. Click on to save the settings.

11. Select whether the switching command should be applicable only for the
selected year (Annual non repeat) or should be repeated every year (Annual
repeat).
> The switching program is shown graphically and tabularly.
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10.4 Annual program - Cycle

Example

Channel 1 is switched ON from January 15 to April 15 every hour for 10

minutes.

Start time Monday 15. January, 9.00 h

Duration 10 min.

Period 1h

Stop time Friday 15. April, 19.00 h
Starting the program , M
1. Start the program and select your time switch. ' |;‘,‘—":;";_x""'“ S _

(see chapter 3) 3. (oo eame] 2 crn e i3

$080 0100 §300 0300 G400 D300 DEDD OT9O CRGO S9GH 1O00 1100 1300 100 MDD 1500 W00 \T00 WD IR0 JUSO IL00 3760 2100
I

In the register, click on the button Annual Programs. Fig. 77: Annual program - Cycle

3. Select in the register the channel for which the annual program should be
created, e.g. CH1 = channell.

> The main menu is opened.

Cycle programming

4. Select the switching command & Gz,

5. Click with the left mouse button in the line for the channel 1 (CH1) on the
field 09:00 h to set the ON switching command and then in the field 19:00 h
to set the OFF switching command.
> The settings window for the pulse duration and the period of the cycle

opens.

I T T |

Fig. 78: Annual program - Cycle 2
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m The pulse duration must not be less than the period.
No nesting of cycle programs is allowed.

6. Set the days, hours, minutes or seconds for the pulse duration.

Pulse duration
oo v oo Wil Wi ¥
dd hin mnm 55

Fig. 79: Annual program - Pulse duration

7. Set the days, hours, minutes or seconds for the period and confirm your input
by clicking on OK.

Cytle Period

dd  hh mm s

o o]

Fig. 80: Annual program - Period

8. Click the left mouse button on January 15 in the calendar, keep the shift key
pressed and click then on April 15.

or

Click the left mouse button on January 15 in the calendar and keep the
mouse button pressed. Move the mouse pointer to April 15 and release the
mouse button.

> The selected days are shown with a white background.
9. Click on ey 1 to save your settings.
> This will open the window “Selection of program*.

Fig. 81: Annual program - Pulse

 Group | StatTme | EndTme = Puseduraon
# e | hh (mm | hh | mm  dd  hh [ mm | ss  d

Fig. 82: Annual program - Table pulse

17




10. Select whether the switching command should be applicable only for the
selected year (Annual non repeat) or should be repeated every year (Annual
repeat).

Please select the type of program required,

| Anouairepeat | | Annual non repeat |

Abb. 83: Annual program - Selection of program
> The switching program is shown graphically and tabularly.

» To edit the date for the ON/OFF switching command, click the left mouse
button two times on the selected switching program in the table and choose
anew date.

Afterwards click on &% to save your settings.
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Switching program for public holidays

4,
5.

6.

Select the switching command & &l

Click with the left mouse button in the line for the channel on the desired

field to set the ON switching command and then in the field for the OFF

switching command.

> The settings window for the pulse duration and the period of the cycle
opens.

Set the hours, minutes or seconds for the pulse duration.

7. Set the days, hours, minutes or seconds for the period and confirm your input

by clicking on OK.
Click on [ram= 1 to select the holidays.
> The settings window "Holidays" opens.

Click on Country/Regions and select the respective country.
CountryRegeon

|Unaed Kingsom |

Fig. 85: Annual program - Country selection

> In the field Public Holidays the public holidays of the respective country
are listed.

RASSLIN

YOUR SENSES. DUR SOLUTIONS.

CountryRegion
|United Kingdom -

Pubiic Holidays
MName Diate {dd rmen yy) -
e ot Doy oio1 a0 Co ]
Geod Friday 0204 2010
| 0404 2010
May Dby Burk by w0110 .
Spring Bank Holiday 31.05.2010 L

A ) [Cwome | [Crowng | [ roea |

Abb. 84: Annual program - Holidays
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10.

v

11.

12.

13.
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Click with the left mouse button in the first table column to select the desired
holiday.
Public Holidays
Name Diate (dd mm.yy) -
New Yoar's Day [0.0namo
Gead Friduy 0204200
04.04. 200
| Enster Wonday 105042010
May Ouy Banik Holiday S0 |
Spring Bark Holday 31052010 L

A ) [(Cwne ]| [Cromng | s |
Fig. 86: Annual program - Selection of public holidays

Click on = to select all public holidays.
Click on (=] to deselect all public holidays.

Click on to select all public holidays with a flexible date such as
Easter.

Click on [Z#=] to select all public holidays with a fixed date such as
Christmas.

Confirm your input with OK.

> The public holidays are shown in bold letters in the calendar.
Click on to save the settings.

> This will open the window “Selection of program*.

Select whether the switching command should be applicable only for the
selected year (Annual non repeat) or should be repeated every year (Annual
repeat).

Please select the type of program required,

| Anouairepeat | | Annual non repeat |

Abb. 88: Annual program - Selection of program
> The switching program is shown graphically and tabularly.

m If flexible days are chosen, the window ,,Calculation of flexible holidays*
opens.

Caleulation of Rewble holidays

Please select the year up to which flexdble holidays should be
automatically calculated,

we s [ o [ cwmm ]

Abb. 87: Annual program - Calculation of flexible holidays

Please select the year up to which flexible holidays should be automatically

calculated and confirm your input with OK.



Switching program from one year to the next

Channel 1 is switched ON every hour for 10 minutes from April 1, 2010 to
March 30, 2011.

Start time Monday April 1,2010,9.00 h

Duration 10 min.

Period 1h

Stop time Friday March 30,2011, 19.00 h
4. Select the switching command E e,

5. Click the left mouse button in the line for the channel 1 (CH1) on the field

11.
12.

09:00 h to set the ON switching command and then in the field 19:00 h to
set the OFF switching command.

> The settings window for the pulse duration and the period of the cycle
opens.

Set the hours, minutes or seconds for the pulse duration.

Set the days, hours, minutes or seconds for the period and confirm your input
by clicking on OK.

Click with the left mouse button on April, 1, 2010 in the calendar, keep the
shift key pressed and click then on December 31, 2010.

Select the year 2011 el @8 =

. Click with the left mouse button on January 1, 2011 in the calendar, keep the

shift key pressed and click then on March 30, 2011.
Click on %% 1 to save the settings.

Select whether the switching command should be applicable only for the
selected year (Annual non repeat) or should be repeated every year (Annual
repeat).

> The switching program is shown graphically and tabularly.

121




11. Astronomic program

The Astro program automatically calculates the daily sunset and sunrise times,
after the coordinates (longitude/latitude) of your location have been entered.

e ON command at sunset.

e QOFF command at sunrise.

Example

A shop window lighting is to be switched automatically ON and OFF from April
1 to September 30 depending on the sunrise and sunset times.

Sunrise = Lighting OFF

Sunset > Lighting ON

Starting the program:

1. Start the program and select your time switch.
(see chapter 3)
> The main menu is opened.

2. In the register, click on the button Astro Programs.

3. Select in the register the channel for which the Astro program is to be
created, e.g. CH1 = channel.
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m If you create and save an Astro program, it is automatically transformed in

an annual program.

If an Astro program is opened again, the individual switching commands are
indicated in the Annual program. It is possible to change the ON and OFF
switching times.
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Fig. 89: Astro program



Location / time zone

To calculate the switching times for your location, the respective geographic m Coordinates can also be entered manually:
coordinates and the time zone are required. Your location is specified by the Longitude: + for North
longitudes and latitudes. The more precise your location is specified, the more — for South
precise are the switching times. )
Latitude: + for East
4. Click on Country/Region and select the respective country. ~ for West
Location
Country/Region
| United Kingdom
City
Fig. 90: Astro program - Country
5. Click on City and select the respective city. roErdlatae ocation
= Longitude Latitude Country/Region
Location London % e e . Tt ek S
CountryRegion [ B 0 Ploo |'le 00 | United Kingdom v
| United Kingdom v
‘m Timezone city
city oueh 1 Ll & London v

ondon

Fig. 91: Astro program - City

Fig. 92: Astro program - Coordinates

> The longitudes and latitudes are automatically entered in the field
"Coordinates".
The time zone is automatically entered in the field "Timezone".
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Daylight saving time
The following settings are possible:

AUTO
In-factory default setting as specified by law (USA or EU). It will be recalculated
every year.

NO
No changeover.

CALIBRATE 2
Manual Programming
The change-over takes place every year on the same date.

Date range

You indicate here the date range during which the Astro program is carried out.
As soon as you click on the respective pull down menu, a calendar appears.
Select the start and end date.

Interval

You can define a time period during with the ON and OFF switching times of the
Astro program are "averaged".

Within this time period - e.g- interval = 10 days - the switching commands are
carried out always at the same time.
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Daylight saving time

) Aute  (only for Europe and USA)

O None

Fig. 93: Astro program - Daylight saving time

Date range
Selection is applied in each successive year

From ~ Interval

011 2 @

Mo Di_Mi Do Fr Sa So

2346687

10.06.2010
Fig. 94: Astro program - Date range

O calibrate 2




Night off period

You can define here the time period during which the time switch should switch

off, e.g. nighttime switch-off from 23 - 5 h.

Night off period
) None

» Activate the box Calibrate and set the desired OFF and ON switching times. ————— Callbrate

Example of a shop window lighting:

— Lighting OFF at sunrise
— Lighting ON at sunset
— Nighttime switch-off from 23 - 5 h.
23h Sunrise
on OfF o ofF
........ | [
Sunset 5h

» Deactivate ON if the nighttime switch-off should last to the next sunset.

Example of a shop window lighting:

— Lighting ON at sunset
— Nighttime switch-off beginning with 23 h.
23h
ON OFF ON
Sunset Sunset

23h

oFF 2 50 &

—— Z]ON 05

Fig. 95: Astro program - Night off period
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Offset

Offset can be used to offset the ON and OFF switching times of the Astro Offset
program. This is done in order to adapt them to the local conditions. sunrise
hh mm
Example: BOEE
Channel 1 CH1 should Sunset
e switch OFF only 45 minutes after the calculated sunrise. LU
) B

Offset = + 00:45

e switch ON already 1 hour and 15 minutes before the calculated sunset.

Offset = - 01:15 Fig. 96: Astro program - Offset

Switching state
Here you can set the command which is to be carried out at sunrise or sunset.

Select between the following switching commands: Program
OFF The time switch switches OFF at sunrise, ShniTee
and switches ON at sunset.
ON The time switch switches ON at sunrise,
and switches OFF at sunset.
PULSE The time switch switches ON at sunrise and sunset for the set
time (pulse).
Maximum pulse switching time: 1 hour, 59 minutes, 59 Fig. 97: Astro program - Program
seconds.
NONE At sunrise, no switching command is carried out.
At sunset, the window for the pulse switching command opens
automatically.
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Applying / deleting an Astro program
1. Click on to apply the Astro program.
> The switching program is displayed in the table.
2. Select in the menu bar File = Save to save the switching program.

» To delete an Astro program, click on the desired program in the table and
afterwards on [_oees ],

or

Click with the right mouse button on the desired Astro program in the table
and delete it.

| 2 | o1
Fig. 98: Deleting an Astro program

» To edit an Astro program, click two times with the left mouse button on the
desired program in the table.

m If you save an Astro program, it is automatically transformed in a annual
program.
If the Astro program is opened again, the individual switching commands
are indicated in the Annual program. It is possible to change the ON and
OFF switching times.

Date range.
‘Seiechon 1 appan I e satesine yea

]
o1 oz

Abb. 99: Astroprogramm




12. Transmission of switching programs via LAN module
12.1 Transmission principle

A switching program created on a PC by means of the software talento dialog
plus can be transmitted via a LAN network or the internet to the LAN module and
is then transferred to the annual time switch via Powerline.

Programs can also be transmitted from the time switch to the PC via the LAN
module.

A LAN module can only be synchronized with one time switch!

12.2 LAN module - Settings GRASSLIN

YOUR SENSES. OUR SOLUTIONS.
Before sending data to the time switch via the LAN module or reading out

data from the time switch, you have to configure the LAN module inthe o, Eolty ol I
software "talento dialog plus"! M A ] \Coimeotion
Workoroupd Hamn | | Cenfiguration
Workgroups  [bsma | [Contiguration

1. Select in the menu bar Options = Configuration - talento LAN plus to Viorkgroupd  foinme | [Corfigusion | )
make settings for the LAN module (talento LAN plus). s — ! %
u Naee.

> The window "Configuration” opens. i | [Catpraen)
Workgroupl Hara | Mﬁm
The software can be used to manage a total number of 10 work groups “wf,,”;;“‘;; ::: : %

with up to 10 LAN modules each.
Fig. 100: Transmission of switching programs - LAN module settings
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Click on to set the respective work group.

Enter the name for your work group, e.g. LAN module

building A.

If the LAN module and the PC are located in the same local network, activate
the box Work in LAN net & worknuasinet ,

Afterwards, click on [“esewmiaimsss |, to search LAN modules which are
already available on the network (see page 130, "Research for LAN modules
in the network").

or

Deactivate the box Work in LAN net ciwexmnusinet if you use the LAN module
via the internet,

IP address, TCP port and HTTP port are automatically assigned by the
Grasslin server.

All parameters can be entered manually in the table:
— Name of the installation, e.g. LAN module 1

— Serial number and MAC address of the LAN module
— IP address (only active if LAN net is activated)
—TCP port (only active if LAN net is activated)

— HTTP port (only active if LAN net is activated)

The column "Web Access" is filled automatically.
Double click with the left mouse button on web to open the start screen of
the administration zone of the LAN module.

Click on to save your settings.

Click on to quit the screen without saving the settings.

Click on to configure the internet access (see page 131,
"Advanced settings").

(ry
YOUR SENSES. OUR SOLUTIONS.

Configuration

Wirkgroup Name

o
o |
g
o ]
O |
g | Discover LAN modules
g

Fig. 101: Transmission of switching programs - LAN module settings 2

eme
YOUR SENSES. OUR SOLUTIONS.
Configuration

Wirkgroup Name

_ooooooooo§

Delete  instafstionMame | SerislMumber  MacAddress  WebAccess  PAddess  TCPPod  WITRPon

[u] LaNmodule 1 0123456789 | ODSO.CZCI-BO0D | wen | 010001003042 23000 | @0
5] U 2 I s | wen | DS3.102098.005 | 2300 | 80
=]

Fig. 102: Transmission of switching programs - LAN module settings 3
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Research of LAN modules in the network G yiY

The research is only possible within a local network! F e I S

1. Activate the window LAN net & workinLanet Configuration

2. Click on to search already existing LAN modules in the Weiiomep Nama ] l?mmwm
> If LAN modules are already installed, they are displayed in the lower o

table.

Apply LAN module:

3. Enter the serial number and the MAC address of the desired LAN modulein 2
the upper table.
4. Double click on the desired LAN module in the lower table. Fig. 103: Transmission of switching programs - LAN module settings 4
> Internet access, HTTP port and TGP port are taken over from the upper
table.
Enter a name for the installation and a name for the work group. p—
Click on to save your settings. VOB SEHAIE, CHIR BOLUNONE.
Click on to quit the screen without saving the settings. Configuration
3.
5. N
4, ————— LANMODULE!  DOUDD0OO39 | 00:SO.CZCI-BO03 | 010.001003034
| LANMODULEZ | 000000043 | DO:SQCZCIE000 | 010.001003.042 | Discover LAN madules
< N

Fig. 104: Transmission of switching programs - LAN module settings 5
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Advanced settings

» Click on to configure the internet access. This is only
necessary if the DNS server has broken down.

E The box Dynamic DNS Server contains the IP address of the Grasslin
server. It cannot be changed.
Dynamic DNS is a service allowing the LAN module to be available on
the Internet at any time despite constantly changing IP addresses. The IP
address is updated on the Grasslin server.

The box Alternate DNS Server remains empty.
Upon failure of the first DNS server, you will receive a new IP address from
Grasslin, which you enter in this box.

» Click on to save your settings.
» Clickon to quit the screen without saving the settings.

Editing/deleting of settings
» To edit the settings, click two times with the left mouse button on the desired
box.

» To delete a LAN module, activate the desired line in the column "Delete" and
click on the button [Fess],

GRASSLIN

YOUR SENSES. DUR SOLUTIONS.

Configuration
Configuration for intemet Access
Dymamic DNS Seqver I
Aarnate DNS server

—

Fig. 105: Transmission of switching programs - LAN module settings 6

RASSLIN

YOUR SENSES. OUR SOLUTIONS.

Configuration

Fig. 106: Transmission of switching programs - LAN module settings 7
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12.3 Sending data (PC - talento LAN plus)

Before sending data to the time switch via the LAN module, the LAN module
must be configured, see chapter 12.2 "LAN module - Settings".

1. Select in the menu bar File > Send to > talento LAN plus
> The window "Upload" opens.
2. Select the desired work group and confirm you selection with ["giesd ],

> The window for the data transmission opens. The data upload is started
automatically.

> A message will appear on the monitor as soon as the transmission was
successful/not successful.
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RASSLIN

YOUR SENSES. OUR SOLUTIONS.
Upload

1 LAN module building A

R ERE ]

Fig. 107: Transmission of switching programs - Upload
epe
RASSLIN
YOUR SENSES. OUR SOLUTIONS.

Upload

LAN moduile bulkiing A

Fig. 108: Transmission of switching programs - Upload 2



12.4 Reading out data (talento LAN plus = PC)

m Before reading out data from the time switch via the LAN module, the LAN
module must be configured, see chapter 12.2 "LAN module - Settings".

1. Select in the menu bar File > Load > talento LAN plus
> The window "Download" opens.

2. In the box Workgroup, choose the desired work group in which the LAN
module is installed. 2.

3. In the box Installation, select the LAN module (installation name) from which 2
the programs are to be read out. ’
4. Click on [Beskad ] to start the reading out process.
> This will open the window "Data transmission".
> If the transmission was successful, the read out program is displayed.

YOUR SENSES. OUR SOLUTIONS.

Download

Wgoup [LAN AW

Installation |LAN modgle 1 -

Lowding daa from: LAN modube 1
{{[11]

Fig. 109: Transmission of switching programs - Download
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13. Transmission of switching programs via the manual programming device

The switching programs created by means of the manual programming device
talento taxxi plus can be transmitted to the respective time switch and vice
versa.

You can transmit the respective switching program exclusively to the
time switch (type) for which the switching program is created.

134

13.1 Transmission principle

The data is transmitted from the PC to the manual programming device or vice
versa via the serial interface COM1 or COM2.

The data is transmitted from the manual programming device to the respective
time switch via a infrared interface or read out from the time switch by the
manual programming device.

The same method is used to transmit the switching programs from time switch
to time switch.

IR interface o~

“Manual programming
device

PC interface

E At the end of this chapter, you will find some information indicated in the
operating manual of the manual programming device , talento taxxi plus*.
For further information, see the separate operating manual "talento taxxi
plus".



13.2 Formate program places on manual programming device

Before switching programs can be transmitted to the time switch, the program
places of the manual programming device must be formated for the respective
time switch.

1. Select in the menu bar Options - Format talento taxxi plus > for talento
892/992 plus or for talento 471/472/671 plus

> The window “Format” opens.

2. In the box Serial Port, choose the desired serial port to which the manual
programming device is connected.

3. Inthe box Program Place, choose the desired program place which you
want to formate.

4. Click on 2 to start the formatting.
> The window “Data transmission” opens.

m The formatting of the program places remains stored as long as a new
formatting takes place.
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Abb. 110: Transmission of switching programs — formate program places
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13.3 Sending data (PC - talento taxxi plus)

m The manual programming device has four storage possibilities:
P 1 = 100 program places

= 300 program places

= 300 program places

800 program places

U U U
B~ o

Display on the manual programming device:
- Program places empty =P 1, P 2 P 3
- Program places occupied = P_1, P_2, P_3,

, P 4
P_4

1. Select in the menu bar File > Send to - talento taxxi plus
> This will open the window "Transmission of switching programs".

2. In the box Reference Time, select the data and the time to be transmitted.
o Activate the box System Time to transmit the current PC date to the
time switch.
o Activate the box Manual if you want to enter the date and time
individually.
3. The box Summer/Winter Time can be used to set the change-over from
summertime to wintertime and vice versa.
m o Activate Auto if the change-over should be carried out according to
the data predefined by law (CET). It will be recalculated every year. A
further change is not possible.
e Activate the box Manual if you want to enter manually the
applicable data for your location/country.
e If you do not want to make a change-over, deactivate in the next
section "Transmit" the box Summer/Winter Time.
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You can decide which contents of the switching program are transmitted:

— System time
— Summertime/wintertime change-over
— Switching programs
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Fig. 111: Transmission of switching programs — taxxi



In the section Transmit the following settings can be made:

4. Activate the box Timer Programs to load the created switching programs
on the manual programming device. You can select the respective program
place to which the switching program/data is to be transmitted by entering it
in the box Program Place.

If the desired program place in the manual programming device is
occupied, it will be overwritten!

5. Select the Serial Port to which the manual programming device is
connected.

m e |f you deactivate the box Timer Programs, only the system time and the
set summertime/wintertime change-over are transmitted.

e Deactivate the box Summer/Winter Time if you do not want a change-
over.

6. Click on[—ek ] to transmit your settings to the manual programming
device.
> This will open the window "Data transmission".
> A message will appear on the monitor as soon as the transmission was
successful/not successful.
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Fig. 112: Transmission of switching programs — taxxi 2
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Fig. 113: Transmission of switching programs — taxxi 3
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13.4 Opening the data (talento taxxi plus = PC)
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You can read out the four program locations of the manual programming
device.

. Select in the menu bar File > Load - talento taxxi plus

> This will open the window "Receipt of switching programs".

In the box Read from Port, select the serial interface of your PC to which the
manual programming device is connected.

In the box Program Place, select the program place whose switching
program is to be read out.

Click on [@ ] to start the reading out process.

> This will open the window "Data transmission".

> If the transmission was successful, the switching program is displayed in
the main window.
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Fig. 114: Receive switching programs — taxxi



13.5 Operating manual of the manual programming device

General Device functions

The manual programming device talento taxxi plus is used to send and
receive switching programs (data).

IR interface

The switching programs are created: NGALISHES IS

e on a PC (laptop) using the software "talento dialog plus"

e directly on the time switch
see operating manual of the time switches

Display
Key out
= sending data

You can transmit the respective switching program exclusively to the time
switch (type) for which the switching program is created.

The taxxi has 4 program locations.
You can transmit 4 different switching programs or read out switching

Key Prog. = selecting a program place

programs.
Display on the manual programming device: PC interface
- Program places empty =P 1, P 2, P 3 P 4
- Program places occupied =P_1, P_2, P_3, P_4
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Transmission of switching programs to the time switch
(talento taxxi plus = time switch)

The time switch must be in the taxxi mode,
see operating manual of the respective time switch.

1. Press the Prog. key to select the respective program place
-P_1..P_4.
To transmit the time, press the Prog. key "c lo".

2. Place the IR interface of the manual programming device directly on the two
IR diodes of the time switch (hold it steady).
3. Press the out key once.
> The transmission is prepared, the corresponding program location and
the allocation out flash alternately.
4. Press the out key once again.

> The data is transmitted. During the transmission, there is an acoustic
signal.

> If the data is correctly transmitted, the number of the program location is
displayed on the manual programming device, e.g. P_1.

> If the data is not correctly transmitted, there will be a short acoustic
signal and a corresponding error message appears on the display.
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Transmission of switching programs to the manual
programming device (Time switch - talento taxxi plus)

The time switch must be in the taxxi mode,
see operating manual of the respective time switch.

1. Press the Prog. key to select the respective program place
-P_1..P_4.
To transmit the time, press the Prog. key to select "c lo".

2. Place the IR interface of the manual programming device directly on the two
IR diodes of the time switch (hold it steady).

3. Press the in key once.
> The transmission is prepared, the corresponding program location and
the allocation in flash alternately.
4. Press the in key once again.

> The data is transmitted. During the transmission, there is an acoustic
signal.

> If the data is correctly transmitted, the number of the program location is
displayed on the manual programming device, e.g. P_1.

> If the data is not correctly transmitted, there will be a short acoustic
signal and a corresponding error message appears on the display.

Error messages of the manual programming device

When working with the taxxi, it is possible that an error message appears on the
display.

e Er 2 = time switch was not recognized (name of the application is not correct)
e Er1 = Data was not correctly transmitted, repeat the transmission
e Er 0 = Batteries do not supply a sufficient voltage
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